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Technical Support
Symantec Technical Support maintains support centers globally. Technical
Support’s primary role is to respond to specific queries about product features
and functionality. The Technical Support group also creates content for our online
Knowledge Base. The Technical Support group works collaboratively with the
other functional areas within Symantec to answer your questions in a timely
fashion. For example, the Technical Support group works with Product Engineering
and Symantec Security Response to provide alerting services and virus definition
updates.

Symantec’s support offerings include the following:

■ A range of support options that give you the flexibility to select the right
amount of service for any size organization

■ Telephone and/or Web-based support that provides rapid response and
up-to-the-minute information

■ Upgrade assurance that delivers software upgrades

■ Global support purchased on a regional business hours or 24 hours a day, 7
days a week basis

■ Premium service offerings that include Account Management Services

For information about Symantec’s support offerings, you can visit our Web site
at the following URL:

www.symantec.com/business/support/

All support services will be delivered in accordance with your support agreement
and the then-current enterprise technical support policy.

Contacting Technical Support
Customers with a current support agreement may access Technical Support
information at the following URL:

www.symantec.com/business/support/

Before contacting Technical Support, make sure you have satisfied the system
requirements that are listed in your product documentation. Also, you should be
at the computer on which the problem occurred, in case it is necessary to replicate
the problem.

When you contact Technical Support, please have the following information
available:

■ Product release level

www.symantec.com/business/support/
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■ Hardware information

■ Available memory, disk space, and NIC information

■ Operating system

■ Version and patch level

■ Network topology

■ Router, gateway, and IP address information

■ Problem description:

■ Error messages and log files

■ Troubleshooting that was performed before contacting Symantec

■ Recent software configuration changes and network changes

Licensing and registration
If your Symantec product requires registration or a license key, access our technical
support Web page at the following URL:

www.symantec.com/business/support/

Customer service
Customer service information is available at the following URL:

www.symantec.com/business/support/

Customer Service is available to assist with non-technical questions, such as the
following types of issues:

■ Questions regarding product licensing or serialization

■ Product registration updates, such as address or name changes

■ General product information (features, language availability, local dealers)

■ Latest information about product updates and upgrades

■ Information about upgrade assurance and support contracts

■ Information about the Symantec Buying Programs

■ Advice about Symantec's technical support options

■ Nontechnical presales questions

■ Issues that are related to CD-ROMs, DVDs, or manuals

www.symantec.com/business/support/
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Support agreement resources
If you want to contact Symantec regarding an existing support agreement, please
contact the support agreement administration team for your region as follows:

customercare_apac@symantec.comAsia-Pacific and Japan

semea@symantec.comEurope, Middle-East, and Africa

supportsolutions@symantec.comNorth America and Latin America

mailto:customercare_apac@symantec.com
mailto:semea@symantec.com
mailto:supportsolutions@symantec.com
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Preparing for installation

This chapter includes the following topics:

■ About changes in NetBackup 7.5

■ About changes in NetBackup 7.1

■ About changes in NetBackup 7.0

■ About NetBackup mixed version support

■ About Symantec Operations Readiness Tools

■ About NetBackup 7.5 availability

■ About NetBackup server installation requirements for UNIX systems

■ About storage device configuration

■ About replacing NetBackup server types not supported in NetBackup 7.x

About changes in NetBackup 7.5
The following describes some important changes to NetBackup version 7.5. For
complete details, see the NetBackup Release Notes for version 7.5.

Note: If you currently use NetBackup 6.x and plan to upgrade to version 7.5, be
aware that NetBackup versions 7.0 and 7.1 contained many changes and
enhancements. Before you upgrade from any 6.x version to 7.5, refer also to the
NetBackup Release Notes for versions 7.0 and 7.1 for complete details. You can
also refer to the following topics for a summary of changes in NetBackup versions
7.0 and 7.1: See “About changes in NetBackup 7.0” on page 23.See “ About changes
in NetBackup 7.1” on page 21.
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Table 1-1 Changes in NetBackup 7.5

DescriptionChange

Starting with NetBackup 7.5, all backup image metadata is
stored in the relational database (NBDB). Previous versions
stored this data in both the NBDB and flat ASCII files (image
header files).

The following describes the advantages of this change:

■ Eliminates the consistency issues for any data that
previously existed in multiple databases.

■ Improves the product search performance, especially in
large catalogs.

■ Improves the performance of restores, policy scheduling,
and image cleanups.

After an upgrade from a previous version of NetBackup,
post-upgrade migration of pre-existing image metadata
from the file system to the NetBackup database occurs.

Caution: This enhancement affects upgrades. To help
ensure a successful upgrade to NetBackup 7.5, please visit
the NetBackup 7.5 Upgrade Portal for complete upgrade
details: http://www.symantec.com/docs/TECH74584

For full details about the image migration process and help
to plan for this migration, refer to the following:

See “About image metadata migration after upgrades to
NetBackup 7.5” on page 15.

See “Planning for image metadata migration after an
upgrade to NetBackup 7.5” on page 19.

Enhanced NetBackup image
metadata management

Preparing for installation
About changes in NetBackup 7.5
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Table 1-1 Changes in NetBackup 7.5 (continued)

DescriptionChange

The following describes the UNIX platform changes:

■ Linux zSeries SUSE 64-bit

This platform now uses SLES 10, patch 2. NetBackup 7.5
cannot be installed on these systems if the OS kernel is
older than 2.6.16.

■ Linux RedHat x86_64 and Linux zSeries RedHat 64-bit

These platforms now use RH 5, update 4. NetBackup 7.5
cannot be installed on these systems if the OS kernel is
older than 2.6.18.

■ Solaris x64

Starting with NetBackup 7.5, this platform supports
Informix 11.

■ Macintosh OS X

This platform now uses version 10.6. NetBackup 7.5
cannot be installed on these client systems if the OS
version is older than 10.6.

UNIX platforms

NetBackup 7.5 completes the native packaging
implementation for servers on the HP-UX, RHEL, SLES, and
AIX platforms as follows:

■ The installation script installs the package by using the
appropriate OS installation command for that server
platform.

■ After the installation has completed, use the appropriate
native package management system query command to
see the list of NetBackup server packages.

■ Removing NetBackup 7.5 and later server software
requires the use of the specific OS package removal
command.

UNIX server packages

This platform is no longer supported for use as a client.Novell NetWare

Server and client support are discontinued for this platform
in NetBackup 7.5.

NetBackup 7.5 provides back-level support only for Windows
IA64 clients.

Windows IA64

13Preparing for installation
About changes in NetBackup 7.5



Table 1-1 Changes in NetBackup 7.5 (continued)

DescriptionChange

Starting with NetBackup 7.5, the NetBackup Product
Improvement Program captures installation deployment
and product usage information.

During the installation, you can choose to participate in the
NetBackup Product Improvement Program and send this
information automatically and in a secured manner to
Symantec. The information received becomes part of a
continuous quality improvement program that helps
Symantec understand how customers configure, deploy,
and use the NetBackup product. This information is then
used to help Symantec identify improvements in product
features, testing, technical support, and future
requirements.

To learn more about the NetBackup Product Improvement
Program, refer to the NetBackup license agreement section
17.19 Privacy; Data Protection. The following describes
where to find the license agreement:

■ UNIX

See the file LICENSE in the base directory of the UNIX
images on the DVD media or from the downloaded media
images from FileConnect.

■ Windows

From the DVD media or the downloaded media images
from FileConnect, start the installation wizard
(Browser.exe). On the Home page, click Installation.
On the Installation page, select either Server Software
Installation or Client Software Installation. On the
Welcome page, click Next to advance to the License
Agmt page.

NetBackup Product
Improvement Program

■ ssh command

Starting with NetBackup 7.5, UNIX clusters can run the
ssh command. The root user guidelines for the ssh
command are the same as those for the rsh command.

■ Cluster node upgrade order

Starting with NetBackup 7.5, you can select whether to
first upgrade the inactive node or the active nodes.

UNIX clusters

Preparing for installation
About changes in NetBackup 7.5
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About image metadata migration after upgrades to NetBackup 7.5
The following information describes important details about the image metadata
migration processes that occur after you upgrade to NetBackup 7.5.

After an upgrade from a previous NetBackup version, post-upgrade migration of
all pre-existing image metadata from the file system to the NetBackup database
occurs.

Please note the following in regard to this migration:

■ The LIST_FS_IMAGE_HEADERS entry is created automatically when the
post-upgrade image metadata migration has completed.

Warning:Do not manually create theLIST_FS_IMAGE_HEADERS entry. Premature
creation of this entry causes non-migrated images to be unrecognized during
NetBackup processing. This problem can result in possible data loss. For a
complete explanation about this entry, see the NetBackup Administrator's
Guide, Volume I.

■ Image metadata consistency checking that is comparable to the bpdbm

-consistency 2 -move command is performed as part of the image metadata
migration.
For more information about consistency checking details and the bpdbm

command, see the NetBackup Commands Reference Guide.

■ Until migration is complete, NetBackup behavior is affected.
See “Planning for image metadata migration after an upgrade to NetBackup
7.5” on page 19.

A number of methods are available to accomplish the migration. Before you
upgrade, review the following information to determine the most appropriate
method to help reduce the effect on normal NetBackup operations:

Review the methods for image metadata migration.In Table 1-2:

Review the NetBackup 7.5 Upgrade Guide.

This guide describes the estimated migration times based
on the migration method and the number of images to be
migrated.

Click on the following link to go to the portal:

http://www.symantec.com/docs/TECH74584

On the NetBackup 7.5
Upgrade Portal:

See “Planning for image metadata migration after an
upgrade to NetBackup 7.5” on page 19.

In theNetBackup Installation
Guide for 7.5:

15Preparing for installation
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Table 1-2 Image metadata migration methods for upgrades to NetBackup 7.5

DescriptionMethod

This method is useful in a backup environment that has the
following:

Acceptable CPU performance and a catalog image count
where NetBackup operations are acceptable during each
step of the serial image migration.

Use this method for environments with or without capacity
managed disk policies, such as SLP or DSSU.

The following describes how this method works:

■ An image is migrated after a NetBackup process updates
the image.

■ At the first instance of the nbstserv process, images
to be deleted, DSSU images, and images associated with
storage lifecycle policy (SLP) jobs are migrated. Auto
Image Replication images are also included.

Note: For more information about nbstserv, see the
NetBackup Administrator's Guide, Volume I.

■ As part of catalog cleanup, any images that are
associated with Advance Disk policies, BasicDisk policies,
and tape policies are migrated.

Typical migration method
(default)
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Table 1-2 Image metadata migration methods for upgrades to NetBackup 7.5
(continued)

DescriptionMethod

This method is useful in a backup environment that has the
following:

Acceptable CPU performance and a catalog image count
where NetBackup operations are acceptable during each
step of the serial image migration.

Use this method if you require AdvancedDisk reporting
immediately after the nbstserv portion of the migration.

The following describes how this method works:

■ Before the upgrade, create the following touch-file:

./netbackup/bin/MERGE_ALL_IMAGE_HEADERS

■ An image is migrated after a NetBackup process updates
the image.

■ At the first instance of the nbstserv process, images
to be deleted, DSSU images, and storage lifecycle policy
(SLP) jobs are migrated. Auto Image Replication images
and any images that are associated with Advance Disk
policies are also included.

■ As part of catalog cleanup, any images that are
associated with BasicDisk policies and tape policies are
migrated.

AdvancedDisk priority
method
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Table 1-2 Image metadata migration methods for upgrades to NetBackup 7.5
(continued)

DescriptionMethod

This method uses the cat_import command and is useful
in a backup environment that has the following:

Acceptable CPU performance, but a catalog image count
that is high enough that you want to reduce the impact on
NetBackup operations during the image metadata migration.

After the nbstserv image migration has completed, and
before the normal catalog cleanup is scheduled to begin,
multiple instances of this command can be run in parallel
to migrate images on a client by client basis. For more details
about the cat_import command, see the NetBackup
Commands Reference Guide.

Before you execute this command, plan your usage as
follows:

■ Determine client priority.

■ Analyze system performance characteristics to
determine the desired number of cat_import
commands to run in parallel.

■ Run concurrent cat_import processes by client
priority.

■ Monitor the migration rate of eachcat_importprocess
to determine performance characteristics.

Large catalog image count
method

While the image metadata migration is in progress, certain NetBackup operations
cannot run while images are merged into their new locations.

The following describes the affected NetBackup operations that cannot run until
after the migration has completed:

■ Fragment deletion of expired disk images does not occur.

■ Capacity managed disk policies such as a storage lifecycle policy (SLP) or a
disk staging storage unit (DSSU) are not likely to start. If they do start, they
may encounter issues with insufficient available space in the disk volume.

■ SLP operations cannot run.

■ Automated Image Replication operations cannot run.

■ Until either the catalog cleanup job or the cat_import image metadata
migration has completed, NetBackup must search for images in both the flat
file system and the NBDB repositories. Therefore, the performance of
NetBackup image catalog queries is affected.

Preparing for installation
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To help you prepare and plan for a successful upgrade, refer to the following topic:

See “Planning for image metadata migration after an upgrade to NetBackup 7.5”
on page 19.

Planning for image metadata migration after an upgrade to NetBackup
7.5

Because each NetBackup environment configuration is unique, post-upgrade
migration performance varies. Factors include but are not limited to environments
with multiple platforms, complex configurations, or very large catalogs.

To help you gauge the amount of time for the migration process to complete, see
the NetBackup 7.5 Upgrade Guide located on the NetBackup 7.5 Upgrade Portal.
Click on the following link to go to the portal:

http://www.symantec.com/docs/TECH74584

To help you prepare for a successful upgrade to NetBackup 7.5, Symantec
recommends that you review the information in the following procedures. Make
any necessary additions to your upgrade plans that apply to your specific backup
environment.

To prepare for monitoring the image metadata migration that occurs after the
upgrade

1 For upgrades from NetBackup 6.5 or later, run the following command to
determine the number of storage lifecycle policy (SLP) image-related records:

■ On UNIX systems:
nbstlutil list -l | grep " I " | wc -l

■ On Windows systems:
nbstlutil list -l | %SystemDrive%\Windows\System32\find.exe

/C " I "

2 Run the following command to determine the number of images in the flat
file system:

Note: Because each NetBackup environment configuration is unique, the
execution time of this command varies. Factors include but are not limited
to environments with multiple platforms, complex configurations, or very
large catalogs.

■ On UNIX systems:
bpimagelist -idonly -d 01/01/1970 00:00:00 | wc -l
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■ On Windows systems:
bpimagelist -idonly -d 01/01/1970 00:00:00 |

%SystemDrive%\Windows\System32\find.exe /C " ID: "

3 Determine the method that you plan to use to accomplish the image metadata
migration, as follows:

■ Review and familiarize yourself with the different methods available to
accomplish the image metadata migration.
See “About image metadata migration after upgrades to NetBackup 7.5”
on page 15.

■ Review the image metadata migration performance data that is related
to the different migration methods.
See the NetBackup 7.5 Upgrade Guide on the NetBackup 7.5 Upgrade
Portal.
http://www.symantec.com/docs/TECH74584

■ With the information from the previous bulleted items, determine the
appropriate method that you plan to use. Document the method steps in
your upgrade plan.

4 For NetBackup configurations that use capacity managed disk storage units
such as an SLP or a disk staging storage unit (DSSU):

Plan to expire additional images from capacity managed disk volumes. For
complete details, see theNetBackup 7.5UpgradeGuide on the NetBackup 7.5
Upgrade Portal:

http://www.symantec.com/docs/TECH74584

5 For backup environments that use disk-based storage units, do the following:

As close to starting the upgrade as possible, run the following command to
delete expired disk image fragments:

nbdelete -allvolumes

After you have completed the previous steps, you are ready to upgrade to
NetBackup 7.5. The upgrade procedure is included in theNetBackup7.5 Installation
Guide.

After you have completed the upgrade procedure, you are ready to perform the
post-upgrade tasks as necessary for the migration method that you selected.

To perform the necessary post-upgrade tasks

1 Monitor the progress of the specific processes in the image metadata migration
method you have selected, as follows:

■ For nbstserv, run the following command:

Preparing for installation
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■ On UNIX systems:
nbstlutil list -l | grep " I " | wc -l

■ On Windows systems:
nbstlutil list -l | %SystemDrive%\Windows\System32\find.exe

/C " I "

Note: For more information about nbstserv, see the NetBackup
Administrator's Guide, Volume I.

■ For the catalog cleanup job, use the Activity Monitor progress log.
In the Jobs tab pane, double-click on the specific image cleanup job. When
the Job Details dialog box appears, click on the Detailed Status tab.

■ For each cat_import process, review the progress indications in STDOUT.

2 Be aware of the expected NetBackup behavior during the image metadata
migration, as follows:

■ While nbstserv is migrating image metadata information:

Fragment deletion of expired disk images does not occur (see step 5 in the
previous procedure).

■ Capacity managed disk policies such as SLP or DSSU are not likely to start.
If they do start, they may encounter issues with insufficient available
space in the disk volume.

■ SLP operations cannot run until after the migration has completed.

■ Automated Image Replication operations cannot run until after the
migration has completed.

■ Until either the catalog cleanup job or the cat_import image metadata
migration has completed, NetBackup must search for images in both the
flat file system and the NBDB repositories. Therefore, the performance
of NetBackup image catalog queries is affected.

3 To get a backup of the new NetBackup databases after the migration has
completed, run a full hot catalog backup.

About changes in NetBackup 7.1
The following describes a summary of important changes in NetBackup 7.1.
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Note: If you currently use NetBackup 6.x and plan to upgrade to version 7.5, be
aware that versions 7.0 and 7.1 contained many changes and enhancements.
Before you upgrade from NetBackup 6.x to 7.5, see the NetBackup Release Notes
for versions 7.0. and 7.1 for complete details.

Starting with NetBackup 7.1, this option is installed with
the NetBackup server and the client packages (if the
platform supports the product). A separate installation or
upgrade procedure is no longer required. However, a valid
license is still required to enable the product and the option
must be configured to be used.

The components have been renamed to NetBackup Product
Authentication and Authorization.

NetBackup Access Control

■ Native packaging for NetBackup clients

NetBackup 7.1 delivers the following NetBackup clients
in their native package formats:

AIX, HP-UX, Linux, and Solaris.

Installation on these systems is unchanged, therefore
the packages are not standalone. However, removal of
NetBackup from these systems now requires the use of
native commands.

See “About NetBackup server software removal on UNIX
systems” on page 105.

All other UNIX client packages are delivered in the same
format as previous versions.

UNIX systems

■ New preinstallation Environment Checker feature

This feature lets you check those computers where you
plan to install or upgrade to NetBackup 7.1 or later. After
you run the Environment Checker, a summary of the
results identifies any potential issues that may prevent
a successful installation or upgrade. Also, a log is
generated that describes the complete results and
identifies which areas to address before you install or
upgrade to NetBackup 7.1 or later.

■ Improved integrated cluster installation and upgrade
process

The process to install and upgrade cluster installations
has been improved to provide feedback to customers,
and to validate cluster environments before
configuration takes place.

Windows systems
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About changes in NetBackup 7.0
The following describes a summary of important changes in NetBackup 7.0.

Note: If you currently use NetBackup 6.x and plan to upgrade to version 7.5, be
aware that versions 7.0 and 7.1 contained many changes and enhancements.
Before you upgrade from NetBackup 6.x to 7.5, see the NetBackup Release Notes
for versions 7.0. and 7.1 for complete details.

This product has reached its end of life and is no longer
supported.

Veritas Storage Migrator
(VSM)

Starting with NetBackup 7.0, NOM has been replaced with
OpsCenter.

If your current 6.x NetBackup environment includes NOM
6.x, you can upgrade NOM to OpsCenter with an upgrade to
NetBackup 7.0 or later.

NetBackup Operations
Manager (NOM)
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Starting with NetBackup 7.0, the following platform support
changes apply:

■ Except for FreeBSD clients and Mac clients, all UNIX
32-bit system support has been discontinued.

To upgrade these systems to NetBackup 7.0 or later, you
must first migrate your current NetBackup 6.x catalogs
and databases to a system with a supported 64-bit
platform.

However, 32-bit media servers and the clients that use
NetBackup 6.x are compatible with NetBackup 7.x 64-bit
master servers.

Also, NetBackup requires OpenStorage vendor plug-ins
to be 64-bit. When you upgrade a media server that is
used for OpenStorage to NetBackup 7.x, you also must
update the vendor plug-in to a 64-bit version.

For details about how to replace the servers that
currently use these unsupported platforms, refer to the
following section:

See “About replacing NetBackup server types not
supported in NetBackup 7.x” on page 37.

■ IRIX and Tru64 are no longer supported.

Servers and clients with these operating systems that
use NetBackup 6.x are compatible with NetBackup 7.x
servers.

■ All 64-bit platforms are supported except for FreeBSD
clients and Mac clients.

■ Windows IA64 is supported only as a client.

■ Linux SUSE and Linux RedHat Itanium are no longer
supported for use as master or media servers. These
platforms are only supported as a client.

■ HP-UX PA-RISC is no longer supported as a master
server. This platform is supported only as a true media
server (media server without the EMM server) or a true
client.

■ Novell NetWare is no longer supported for use as a media
server. This platform is only supported as a client.

Platform and operating
system support changes
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Starting with NetBackup 7.0, most of the add-on products
and database agents are now installed with the NetBackup
server or the client package. Separate installation for these
products is no longer needed.

The following products are now included in the NetBackup
server package (if the platform supports the product):

■ BMR master server

■ NDMP

■ Vault

The following products are now included in the NetBackup
client package (if the platform supports the product):

■ BMR Boot server

■ DB2

■ Encryption

■ Informix

■ LiveUpdate agent

■ Lotus Notes

■ Oracle

■ SAP

■ Snapshot Client

■ Sybase

The binaries for the listed products are laid down with the
server or the client package. A valid license is still required
to enable the product. If product configuration was required
previously (such as db2_config), configuration is still
required.

Note: For Solaris server upgrades, the older versions of any
listed products here must be removed before an upgrade to
NetBackup 7.0 or later. For example, VRTSnbdb2,
SYMCnbdb2, VRTSnbenc, SYMCnbenc, and others. The
installation script displays a list of the packages it finds that
must be removed.

The French, Japanese, and the Chinese language packages
remain as separate add-ons. The process to install and
upgrade these products remains the same.

UNIX package consolidation

New NetBackup 7.0 or later media server installations
cannot be clustered. However, existing 6.x clustered media
servers can be upgraded to version 7.0 or later and remain
clustered.

Clustered media server
support changes
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About NetBackup mixed version support
You can run mixed versions of NetBackup between master servers, media servers,
and clients. This back-level support lets you upgrade NetBackup one server at a
time, which minimizes the effect on overall system performance. Symantec
supports only certain combinations of servers and clients.

Table 1-3 lists the supported mixed version configurations for NetBackup 7.5.

Table 1-3 Supported NetBackup mixed version configurations

Client versionMedia server
version

Master server
version

Configuration

7.5

(For catalog backups,
see the note
immediately after
this table.)

7.57.51

6.0.x, 6.5.x, or 7.x

(For catalog backups,
see the note
immediately after
this table.)

7.57.52

6.0.x, 6.5.x, or 7.x

Clients in this
configuration must
use a version that is
equal to or earlier
than media server
versions.

(For catalog backups,
see the note
immediately after
this table.)

6.0.x, 6.5.x, or 7.x7.53

Note: The NetBackup catalog resides on the master server. Therefore, the master
server is considered to be the client for a catalog backup. If your NetBackup
configuration includes a media server, it must use the same NetBackup version
as the master server to perform a catalog backup.
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NetBackup versions 7.0 and later do not support Windows 2000 systems. However,
you can still use NetBackup version 6.x on Windows 2000 clients with your
NetBackup 7.x servers.

The following describes what type of action to take if you have any clients that
run Windows 2000:

No action is required. These clients are compatible
with NetBackup version 7.x master and media
servers.

To ensure future compatibility, it is recommended
that you replace these clients with those that use
a more current operating system.

Existing NetBackup customers with
Windows 2000 clients at NetBackup
version 6.x:

You must install NetBackup version 6.x client
software on your Windows 2000 systems.

To obtain NetBackup version 6.x, contact your
Symantec NetBackup representative or call
technical support.

New NetBackup customers with
Windows 2000 systems:

For complete information on mixed version support, see the NetBackup Release
Notes for version 7.5. Refer to the section "NetBackup backward compatibility".

About Symantec Operations Readiness Tools
Symantec Operations Readiness Tools (SORT) is a set of Web-based tools that
supports Symantec enterprise products. For NetBackup, SORT provides the ability
to collect, analyze, and report on host configurations across UNIX/Linux or
Windows environments. This data helps to assess whether your systems are ready
for an initial NetBackup installation or for an upgrade from your current version.

To access SORT, go to the following Web page:

http://sort.symantec.com/netbackup

Once you get to the SORT page, more information is available as follows:

■ Installation and Upgrade Checklist
Use this tool to create a checklist to see if your system is ready for a NetBackup
installation or an upgrade.

■ Hot fix and EEB Release Auditor
Use this tool to find out whether a release that you plan to install contains the
hot fixes that you need.

■ Custom Reports
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Use this tool to get recommendations for your system and Symantec enterprise
products, tips for risk assessment, and product license tracking.

About NetBackup 7.5 availability
NetBackup 7.5 is available in the following formats:

■ DVD media kit
All necessary software and documentation files are provided on several DVDs.
See “About the NetBackup media kit” on page 28.

■ Electronic Software Distribution (ESD) images
The DVD image files are posted and available for download on the FileConnect
Website.
See “About the NetBackup Electronic Software Distribution (ESD) images”
on page 30.

About the NetBackup media kit
The media kit includes a DVD for each supported UNIX platform or operating
system and one DVD for Windows. The label on each DVD provides a brief
description of its contents.

NetBackup documentation is also included. All documentation for the NetBackup
software products in this release is included.

Printed materials include a Getting Started Guide. Documentation on the DVDs
is in Portable Document Format (PDF). You can use Acrobat Reader to open, view,
and print the files.

If Autorun is enabled on your Windows system, you see a Web page that lists the
documents that you can select to view. On UNIX or Linux systems, or if Autorun
is disabled on the Windows system, navigate to the DVD drive to view the DVD
contents. From that drive, you can select the documents to view or copy them to
a local drive.

The following table describes the contents of each DVD.

Table 1-4 NetBackup 7.5 DVD contents

ContentsPlatform OSDVD No.

■ Server and supported options

■ NetBackup documentation

AIX 64-bit1
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Table 1-4 NetBackup 7.5 DVD contents (continued)

ContentsPlatform OSDVD No.

■ Server and supported options

■ NetBackup documentation

HP-UX IA642

■ Media server and supported
options

■ NetBackup documentation

HP-UX PA-RISC 64-bit3

■ Server and supported options

■ NetBackup documentation

Linux RedHat x86_644

■ Server and supported options

■ NetBackup documentation

Linux SUSE x86_645

■ Server and supported options

■ NetBackup documentation

Solaris SPARC646

■ Server and supported options

■ NetBackup documentation

Solaris x86-647

■ Server and supported options

■ All x86 and x64 clients

■ NetBackup documentation

Windows x86 and x648

■ Media server and supported
options

■ NetBackup documentation

Linux zSeries RedHat x649

■ Media server and supported
options

■ NetBackup documentation

Linux zSeries SUSE x6410

■ All UNIX clients

■ NetBackup documentation

UNIX clients11

■ All UNIX and Windows clients in
LiveUpdate format

■ Readme document

Clients in LiveUpdate format12

■ All Windows platforms

■ ICS (NBAC)

OpsCenter (1 of 3)13
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Table 1-4 NetBackup 7.5 DVD contents (continued)

ContentsPlatform OSDVD No.

■ RedHat

■ SUSE

■ Solaris x86

■ ICS (NBAC)

OpsCenter (2 of 3)14

■ AIX

■ HP-UX IA64

■ Solaris SPARC

■ ICS (NBAC)

OpsCenter (3 of 3)15

NetBackup Client for OpenVMSOpenVMS (CD format)16

See “About the NetBackup Electronic Software Distribution (ESD) images”
on page 30.

See “About NetBackup server installation requirements for UNIX systems”
on page 30.

About the NetBackup Electronic Software Distribution (ESD) images
The ESD images for NetBackup 7.5 are available for download from the FileConnect
Web page. The images adhere to a 1.8G size limitation.

To ensure the accuracy of the ESD download, some of the product images have
been split into smaller, more manageable files. Before you uncompress any file,
you must first join the split image files that you can identify as 1 of 2 and 2 of

2. A Download Readme.txt file on FileConnect describes how to join the files
together.

See “About NetBackup 7.5 availability” on page 28.

See “About the NetBackup media kit” on page 28.

About NetBackup server installation requirements
for UNIX systems

Before you install NetBackup, make sure that your backup environment meets
the following requirements:
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Make sure that you have the following hardware and
software already set up:

■ All NetBackup installation DVDs or ESD images,
appropriate license keys, and the root password for all
servers.

■ The gzip and the gunzip commands must be installed
on the local system. The directories where these
commands are installed must be part of the root user’s
PATH environment variable setting.

■ A server of a supported hardware type that runs a
supported version of its operating system (with
applicable patches), adequate disk space, and supported
peripherals. For details on these requirements, refer to
the NetBackup Release Notes.

■ All NetBackup servers must recognize and be
recognizable by their client systems. In some
environments, this means that each must be defined in
the other’s /etc/hosts file. Other environments may
use the Network Information Service (NIS) or Domain
Name Service (DNS).

■ For reasonable performance of the NetBackup-Java
interfaces, you need 512 MB of RAM. Of that space, 256
MB must be available to the interface program (jnbSA
or jbpSA).

■ The minimum screen resolution configuration is
1024x768, 256 colors.

General requirements

Symantec recommends that you remove any other vendor
backup software currently configured on your system before
you install this product. Other vendor backup software can
negatively affect how NetBackup installs and functions.

Other backup software

Ignore references to media servers if you do not plan to
install any. They are not required.

Media servers

To accommodate the NetBackup server software and
NetBackup catalogs, Symantec recommends the following:

■ Master and media servers in a production environment
with several database agents enabled, should have a
minimum of 2 GB of memory each.

■ Any client should have a minimum of 512 MB of memory
in this type of environment.

Memory considerations
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On the NetBackup server, the installation directory contains
the software and the NetBackup catalog. Both of these can
become quite large.

If space is an issue, you can install NetBackup on an
alternate file system. The installation lets you select an
alternate install location, and creates the appropriate link
from /usr/openv.

Disk space considerations

Symantec does not support installation of NetBackup in an
NFS-mounted directory. File locking in NFS-mounted file
systems can be unreliable.

NFS compatibility

For some peripherals and platforms, kernel reconfiguration
is required.

For more details, see the NetBackup Device Configuration
Guide.

Kernel reconfiguration

For Red Hat Linux, NetBackup requires server networking.Red Hat Linux

About file descriptor limits for UNIX and Linux systems
To help NetBackup run efficiently, Symantec recommends that you set the file
descriptor limit (soft limit) on UNIX and Linux systems to at least 8000.

To check the current operating system (OS) file descriptor setting, use the following
command:

# /usr/bin/ulimit -a

In the command output, look for the nofiles(descriptors) entry.

The following describes the affected file and parameters for each OS:

To set a permanent limit, in the /etc/system file, add the following
lines:

* rlim File Descriptors

set rlim_fd_max=65536

set rlim_fd_cur=8000

Where max is the maximum file descriptors on the system, and cur
shows the maximum file descriptors per process.

Solaris

In the /etc/security/limits file, add the following line

nofiles = 8000

Note: On AIX systems, the hard limit is unlimited.

AIX
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From the Systems Administrator’s Menu (SAM), in the
/etc/sysconfigtab file, change the nfiles setting to 8000.

HP

In the/etc/security/limits.con file, add the following lines:

* soft nofile 8000

* hard nofile 65535

Linux

After you change any of these settings, you must restart the NetBackup server.

For more information on setting file descriptors, refer to your OS documentation.

For more information on recommendations for changing file descriptor settings,
refer to the following tech notes:

http://www.symantec.com/docs/TECH15131

http://www.symantec.com/docs/TECH70191

http://www.symantec.com/docs/TECH75332

http://www.symantec.com/docs/TECH137761

Special installation guidelines for Solaris systems
Several kernel-tunable parameters, such as Message Queue, Semaphore, and
Shared Memory Parameters, can affect NetBackup performance. If you adjust
these values, you may prevent your system performance from slowing down or
even reaching a deadlock state.

For more information about parameter definitions and examples, see the
NetBackup Backup Planning and Performance Tuning Guide on the support Web
site.

The following examples show how you may need to modify certain parameters
for Solaris 10 systems:
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■ It may be necessary to increase the system’s message
queue resources to avoid having NetBackup daemons
hang.

For example, you may need to edit the /etc/system
file to include or change the following parameters:

set msgsys:msginfo_msgmap=512
set msgsys:msginfo_msgmax=8192
set msgsys:msginfo_msgmnb=65536
set msgsys:msginfo_msgmni=256
set msgsys:msginfo_msgssz=16
set msgsys:msginfo_msgtql=512
set msgsys:msginfo_msgseg=8192

After editing the file, you must reboot the NetBackup
server.

Message Queue parameters

■ You must allocate enough semaphores on UNIX systems,
or errors may occur. System requirements vary, but the
following changes to the /etc/system file should be
sufficient for an average system:

set semsys:seminfo_semmap=64
set semsys:seminfo_semmni=1024
set semsys:seminfo_semmns=1024
set semsys:seminfo_semmnu=1024
set semsys:seminfo_semmsl=300
set semsys:seminfo_semopm=32
set semsys:seminfo_semume=64

After editing the file, you must reboot the NetBackup
server.

Semaphore parameters

Special installation guidelines for HP-UX systems
Use the following guidelines when you install NetBackup on HP-UX systems:

■ Install NetBackup on a file system that supports long file names.

■ During NetBackup installation, the following error may occur when the
NetBackup database is created:

SQL error (-832) -- Connection error: Insufficient system

resources - failed to allocate a SYSV semaphore

To correct the error, increase the number of semaphores in the HP-UX kernel.
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For details on how to change HP-UX parameters, see the NetBackup Backup
Planning and Performance Tuning Guide, Chapter 11: OS-Related Tuning
Factors.

Special installation guidelines for UNIX clustered environments
Use the following guidelines when you install NetBackup in clustered systems:

■ Ensure that each node in the NetBackup cluster can run the rsh command or
its equivalent (on HP-UX, the command is remsh). Starting with NetBackup
7.5, you can also use the ssh command. The root user must be able to perform
a remote login to each node in the cluster without entering a password. This
remote login is necessary for installation and configuration of the NetBackup
server and any NetBackup options. After installation and configuration are
completed, it is no longer required.

■ You must install, configure, and start the cluster framework before you install
NetBackup. For additional installation prerequisites and installation notes,
see the NetBackup Clustered Master Server Administrator’s Guide.

■ You must have defined a virtual name using DNS, NIS, or /etc/hosts. The IP
address is defined at the same time. (The virtual name is a label for the IP
address.) Use this virtual name and IP address only for the NetBackup resource.

About NetBackup Access Control
Starting with NetBackup 7.1, NetBackup Access Control (NBAC) is installed with
NetBackup. However, the option still requires a valid license key and must be
configured for use. For complete details, see theNetBackupSecurityandEncryption
Guide.

If you currently use NBAC in NetBackup versions 6.x through 7.0.1, a separate
upgrade is no longer required. Upgrades to version 7.x automatically migrate all
NBAC files from a shared location to a location within NetBackup.

See “How to install NetBackup” on page 51.

See “About NetBackup server installation requirements for UNIX systems”
on page 30.

About storage device configuration
Reliable use of NetBackup depends on the proper configuration of your storage
devices. To ensure reliable backups and restores, you must first install and
configure devices to work with the operating system.
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Before you install or upgrade to NetBackup 7.1 or later, use the following guidelines
to configure storage devices to work with the operating system:

Before you install or upgrade to NetBackup 7.1 or later,
Symantec recommends that you install and configure your
devices with the latest version of drivers.

New installations and
upgrades

To prepare and connect new devices, perform the following
tasks:

■ Set the SCSI ID (target). Make sure that it is set it to an
available SCSI ID.

■ Physically attach your device to a compatible host bus
adapter where that SCSI ID is available.

Compatible means that both the device and the host bus
adapter are of the same type. For example, single-ended,
high voltage differential, low voltage differential, or
Fibre Channel.

Connections and settings

To configure storage devices to work with the operating
system, refer to the following documentation:

■ The instructions from the device and the operating
system vendors.

■ The NetBackup Device Configuration Guide. See the
chapter that is appropriate for your operating system.

Configuration

After all storage devices are installed, configured, and
verified to work with the operating system, you can install
NetBackup.

NetBackup installation

Warning: An improperly configured device can lead to backup failures, data loss,
or both.

See “About NetBackup server installation requirements for UNIX systems”
on page 30.

Locating supported robot types
You can find a list of the supported robot types in the Symantec NetBackup
Server/Enterprise Server 7.x Hardware Compatibility List.

For your convenience, Symantec periodically updates this document on the
Symantec support Web site.
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To find the latest robot types that this release supports

◆ Click on the following link to access theSymantecNetBackupServer/Enterprise
Server 7.x Hardware Compatibility List:

http://www.symantec.com/docs/TECH76495

About replacing NetBackup server types not
supported in NetBackup 7.x

Certain hardware support and operating system support has been discontinued
in NetBackup 7.x. These systems must be replaced with supported systems before
an upgrade to NetBackup 7.x.

For complete details about hardware and operating system support in NetBackup
7.x versions, refer to the following documents:

■ NetBackup Release Notes for 7.5
http://www.symantec.com/docs/DOC5041
Refer to the sections "About platform and operating system support changes"
and "About NetBackup Compatibility Lists".

■ NetBackup Enterprise Server and Server 7.x OS Software Compatibility List
http://www.symantec.com/docs/TECH76648

■ NetBackup server 7.x hardware compatibility list
http://www.symantec.com/docs/TECH76495

The following describes the general guidelines to replace unsupported servers
before an upgrade to NetBackup 7.x:
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The platform and the architecture of the new system can
be different than the system that you replace, provided that
you observe the following rules:

■ An unsupported Windows server (hardware or operating
system) should be replaced with a supported Windows
server.

■ An unsupported UNIX or Linux server (hardware or
operating system) should be replaced with any other
supported UNIX or Linux server platform and operating
system. However, Red Hat Linux master servers are an
exception (see the following item).

■ An unsupported Red Hat Linux master server must be
replaced by another Red Hat Linux master server. The
version of Red Hat Linux and the server architecture
may be different.

For complete details on replacing NetBackup servers in
regard to platforms and operating systems, refer to the
following documents on the Symantec support Web site:

■ For Windows master servers:

http://www.symantec.com/docs/TECH77447

■ For UNIX master servers:

http://www.symantec.com/docs/TECH77448

■ For media servers:

http://www.symantec.com/docs/TECH77811

■ OpenStorage users should also refer to the following
document for details about specific considerations in
regard to upgrades to NetBackup 7.x:

http://www.symantec.com/docs/TECH77812

Platform and operating
system

The new supported system must use the exact same version
of NetBackup as the old system. You cannot migrate catalogs
and databases from one NetBackup version to a different
version.

For example, the old server uses NetBackup 6.5.2. You must
install this same version on the new server before you can
upgrade.

NetBackup version
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On the old system, you must create a hot catalog backup.
This backup is then used to restore the catalog to the new
supported system and complete the migration.

The method that you use to create the catalog backup can
make a difference in how you restore it on the new system.
For example:

■ Whether you back up the catalog to tape or disk

■ Whether you back up the catalog to a master server or
a media server

For complete details on how to create a hot catalog backup,
see the NetBackup Troubleshooting Guide.

Hot catalog backup

How to replace unsupported NetBackup master servers
The following steps describe only the primary tasks to replace an unsupported
master server.

For complete detailed instructions, refer to the following documents on the
Symantec support Web site:

http://www.symantec.com/docs/TECH77447

http://www.symantec.com/docs/TECH77448

OpenStorage users should also refer to the following document for details about
specific considerations in regard to upgrades to NetBackup 7.x:

http://www.symantec.com/docs/TECH77812

To replace an unsupported master server

1 Configure a new supported master server with the same name as the old
unsupported master server.

See “About replacing NetBackup server types not supported in NetBackup
7.x” on page 37.

2 Install the same version of NetBackup on the new master server that is used
on the old master server.

You must install NetBackup to the exact same path and location as the old
server.

3 On the old master server, create a hot catalog backup.

For complete details on how to create a hot catalog backup, see theNetBackup
Troubleshooting Guide.

4 Shut down the old master server and remove it from your backup
environment.
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5 Install the new master server in your backup environment.

6 Restore the catalog backup.

7 Run some test backups and restores to verify successful operation.

After you verify successful operation, you can upgrade to NetBackup 7.x.

How to replace unsupported NetBackup media servers
The following steps describe only the primary tasks to replace an unsupported
media server.

For complete detailed instructions, refer to the following document on the
Symantec support Web site:

http://www.symantec.com/docs/TECH77811

OpenStorage users should also refer to the following document for details about
specific considerations in regard to upgrades to NetBackup 7.x:

http://www.symantec.com/docs/TECH77812

To replace an unsupported media server

1 Deactivate the old media server through the NetBackup Administration
Console, or by running the following command:

nbemmcmd -updatehost -machinename <Media Server> -machinestateop

set_admin_pause -machinetype media -masterserver <Master Server>

2 Shut down the old media server.

3 Configure a new supported media server with the same name and IP address
as the old media server.

Note: To use a new IP address, make sure that you update the DNS.

4 Connect all backup storage devices to the new media server.

5 Install the same version of NetBackup on the new media server that is used
on the old media server. You must install NetBackup to the exact same path
and location as the old server.

Also, make sure that you specify the same list of additional servers that were
identified on the old server.

6 Install the new media server in your backup environment.
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7 Activate the new media server through the NetBackup Administration Console,
or by running the following command:

nbemmcmd -updatehost -machinename <Media Server> -machinestateop

clr_admin_pause -machinetype media -masterserver <Master Server>

8 Run the device discovery on the new media server so that all connected backup
storage devices are recognized.

9 Run some test backups and restores to verify successful operation.

After you verify successful operation, you can upgrade to NetBackup 7.x.
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NetBackup licenses

This chapter includes the following topics:

■ About NetBackup license key requirements

About NetBackup license key requirements
To install NetBackup master server or media server software, you must enter a
NetBackup product license key.

To obtain license keys, you must order a license SKU when you order your
NetBackup products.

After you place your order, Symantec sends you an email with a license certificate
that includes the following information:

This list includes all of the licenses for the products that
you ordered.

Keep this list in a secure location. You may be asked for a
product license key if you ever need to contact technical
support for assistance.

List of NetBackup licenses
purchased

Instead of a DVD media kit, you can use this serial number
to download the Electronic Software Distribution (ESD)
images for NetBackup product installation.

Go to the following Web site and enter this serial number
to download the ESD images to your system:

https://fileconnect.symantec.com/LangSelection.jsp

Serial number for access to
download NetBackup
products

When you install NetBackup, Symantec recommends that you enter all other
product license keys on the master server when you are prompted. Although you
can add these license keys later, it is easier to enter them when you install the
master server software.
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For detailed information on how to administer NetBackup license keys, refer to
the NetBackup Administration Guide, Volume I.

See “About NetBackup server installation requirements for UNIX systems”
on page 30.

About NetBackup license compatibility
To use your current NetBackup license keys to upgrade servers, add-on products,
and database agents to NetBackup 7.5, the following are required:

■ NetBackup versions 6.x or 7.0.x must already be installed.

■ You must have a valid maintenance contract for all licensed NetBackup
products.

Note: You cannot upgrade to NetBackup 7.5 if your current installed version is
NetBackup 5.x. You must first upgrade to NetBackup 6.0 or 6.5, and then you can
upgrade to NetBackup 7.5. Any 6.x version can be upgraded directly to 7.5.

Upgrade licenses and software may be obtained from the Symantec Licensing
Portal at the following Web site:

https://licensing.symantec.com/acctmgmt/index.jsp

For detailed information and procedures on how to administer license keys, refer
to the NetBackup Administrator’s Guide, Volume I.

See “About license key entry” on page 44.

About license key entry
License keys for all NetBackup SKUs must be entered on the master server. License
keys for some SKUs must also be entered on the media server, depending on the
capabilities that you require for the media server.

Table 2-1 describes the license keys that must be entered on each server.
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Table 2-1 Required license keys for NetBackup media servers

Required licenses (based onmedia server capabilities)Media server type

■ NetBackup Enterprise Server 7.5 UNX

■ NetBackup Enterprise Server 7.5 WIN/LNX/SOLX64

■ NetBackup Standard Infrastructure 7.5 XPLAT1 Front
End TBYTE

■ NetBackup Enterprise Infrastructure 7.5 XPLAT1 Front
End TBYTE

■ NetBackup Platform Base

■ NetBackup Option Library Based Tape Drive 7.5 XPLAT

■ NetBackup Option Shared Storage Option 7.5 XPLAT

■ NetBackup Option NDMP 7.5 XPLAT

■ NetBackup Media Server Encryption Option for
Enterprise Server, UNIX

■ NetBackup Media Server Encryption Option for
Enterprise Server, Windows/Linux

Enterprise media servers

■ NetBackup Enterprise Client, UNIX

■ NetBackup Enterprise Client, Windows/Linux

■ Media Server Encryption Option for SAN Media Server
(Enterprise Client), UNIX

■ Media Server Encryption Option for SAN Media Server
(Enterprise Client), Windows/Linux

SAN media servers

Enter license keys by using one of the following methods:

■ During NetBackup master server and media server installation (recommended)
The installation script prompts you to enter the license keys for all NetBackup
products that you plan to install.

■ NetBackup Administration Console
After NetBackup master server or media server installation, open the console
and click Help > License Keys.

■ Command-line interface (UNIX only)
After NetBackup master server or media server installation, use the following
command:

/usr/openv/netbackup/bin/admincmd/get_license_key
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Note: You can log on to a NetBackup server from almost any server in a system
to view, enter, and administer license keys. When you administer license keys
remotely, make sure that you view the licenses of the system you intend to change.
You do not want to add or change a license key on the wrong server.

Frequently asked questions about license keys
Symantec customers have asked the following questions about how to manage
license keys.

NetBackup uses a common license system that other
Symantec products also use. Please remember, however,
that the common license system provides flexibility in the
license features that each product implements. For example,
NetBackup does not have a node-locked license system, but
some other products do.

Is the license system for
NetBackup the same as the
license system in other
Symantec products?

No. The media kit by itself does not allow any access to
NetBackup. You always need a license key (either permanent
or evaluation). License keys should always be delivered with
the media kit, so you should never find yourself with a media
kit and no key.

Can I use NetBackup if all I
have is a media kit?

The key is a multi-digit alphanumeric string (for example:
8EPP-ABCD-9XYZ-XYZ9-8881-VCF4-OIUF-AJDC). The key
contains information on the following:

■ Whether the key is for NetBackup Server or NetBackup
Enterprise Server

■ Whether the key is for a server, a client, an agent, or an
option (and which one)

■ Whether the key is a permanent key or an evaluation
key

■ Information about how and where the key was generated

What does the license key
look like? What information
does it contain?

Yes, serialization information is embedded in the key.Is the license key serialized?
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Yes. Information about license keys is stored on the master
server.

To access the information, open the NetBackup
Administration Console and select Help > License Keys.

On UNIX servers, you can also run the following command:

/usr/openv/netbackup/bin/admincmd/get_license_key

For more information on how to view reports, refer to the
NetBackup Administrator’s Guide, Volume I.

Can I see reports on what
license keys I have?

When you install NetBackup, you are prompted to enter the
license keys for all options and agents.

If you purchase an agent or other add-on product at a later
date, you can enter its license key manually. Open the
NetBackup Administration Console and select Help >
License Keys.

On UNIX servers, you can also run the following command:

/usr/openv/netbackup/bin/admincmd/get_license_key

Some options require that you have your original NetBackup
DVDs, because additional binaries must be installed. You
should always keep your NetBackup DVDs in a safe place.

How do I enable options and
agents?

Yes. Always store copies of your license keys in a secure
place.

Should I save license keys
after they have been entered?

Symantec has a record of all license keys that are issued to
customers. Customers who lose their license key(s) can call
Order Management to get copies of their license keys.

■ For Americas, Japan, PacRim, Australia:

650.318.4265 FAX: 650.335.8428

■ For Europe, Middle East and Africa:

00.353.61.365232 FAX: 00.353.61.365223

If you have purchased NetBackup from a Symantec partner,
you need to contact that partner for information on your
key.

What should I do if I have
lost my license key(s)?
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Many NetBackup installations are very large, and the license
keys are long. License keys that you enter multiple times
can be time-consuming. You can request a single license
key for each type of NetBackup component you purchase.
For example, you can obtain one license key for use with 50
Oracle agents. Site licenses enable unrestricted use for
specific NetBackup agents or options.

You still need a unique license key for each type of
NetBackup component that you purchase. Separate license
keys are required for components like NetBackup Server, a
Lotus Notes agent, or any NDMP option.

How are large volume orders
handled?

Site licenses are handled much like large volume orders are.
The certificate for a site license states that the license key
is good for unlimited copies.

What about license keys for
customers with site licenses?

No. NetBackup Remote Administration Consoles do not
require special license keys. You can install them on any
computer with access to the master server.

Do I need a license key to
enable NetBackup Remote
Administration Consoles?

Yes. You can use your license keys multiple times. You are,
however, legally bound to install and use only the number
of NetBackup servers, clients, agents, and options for which
you purchase licenses.

Can a license key be used
multiple times?

All NetBackup customers who have current maintenance
contracts with Symantec automatically receive the latest
version of NetBackup. You receive the NetBackup media kit
and license keys for every component for which you
purchased licenses.

If your maintenance is through a Symantec partner, you
upgrade through the partner. Contact the partner for more
details.

How do existing customers
get license keys?

If you believe that you received an incorrect license key,
contact Order Management using the number on your
license key certificate. Technical support does not issue
permanent license keys. You can obtain license keys only
through Order Management. Technical support can provide
temporary one-month license keys to you while issues
regarding permanent license keys are resolved.

What if I do not get the right
license keys?

The evaluation license key enables unrestricted use of
NetBackup, its agents, and its options for a predetermined
period of time.

What does an evaluation
license key enable?
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To find out when a license key expires, open the NetBackup
Administration Console and select Help > License Keys.

On UNIX servers, you can also run the following command:

/usr/openv/netbackup/bin/admincmd/get_license_key

Am I notified when an
evaluation is about to expire?

The NetBackup services or daemons are shut down. When
you attempt to use the product you are informed that its
evaluation period has expired.

What happens when an
evaluation license key
expires?

Yes. Customers who add a permanent license key to an
evaluation version of NetBackup have immediate access to
their catalog information and configuration information.

Does NetBackup save the
backup configuration and
catalog information when
evaluation license keys
expire?

It is easy. When you purchase a permanent license, you add
that license to NetBackup. All the configuration information
and catalog data from your evaluation version is retained.

To enter your permanent license key, open the NetBackup
Administration Console and select Help > License Keys.

On UNIX servers, you can also run the following command:

/usr/openv/netbackup/bin/admincmd/get_license_key

How do I upgrade from an
evaluation license to a
permanent license?
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Installing server software

This chapter includes the following topics:

■ How to install NetBackup

■ About mounting the NetBackup software media

■ Installing NetBackup master server software on UNIX

■ Installing NetBackup media server software on UNIX

■ About pushing client software from a master server to clients

■ Installing NetBackup add-on products

■ How to configure the window manager for the Java Interface (NetBackup-Java
compatible platforms)

How to install NetBackup
For new NetBackup installations, install the software in the following order:

Install master server software.Step 1

Install media server software (NetBackup Enterprise only).Step 2

Install the NetBackup Remote Administration Console (optional).Step 3

Install client software.Step 4

Install any NetBackup add-on products (such as language packages).Step 5

Before you proceed with any installation procedure, be sure to review the
installation requirements.
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See “About NetBackup server installation requirements for UNIX systems”
on page 30.

How the installation script works
When you install NetBackup server software, client software is also installed.

When you install NetBackup 7.5, the following options are also installed if the
platform supports them:

■ BMR Master Server

■ NDMP

■ Symantec Product Authentication and Authorization (NetBackup Access
Control)

■ Vault

■ BMR Boot Server

■ DB2

■ Encryption

■ Informix

■ LiveUpdate agent

■ Lotus Notes

■ Oracle

■ SAP

■ Snapshot Client

■ Sybase

After installation is complete, a valid license key for each option must be entered
to enable its functionality. Each option must also be configured as needed.

In addition to server software and options, the installation script performs the
following tasks:

Places the host name in the
/usr/openv/netbackup/bp.conf file on the server.

For clustered environments, the script places the virtual
host name in the /usr/openv/netbackup/bp.conf file
on the server.

Host names
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Adds automatic startup and shutdown scripts to the
appropriate directories on the various supported platforms.

Automatic startup and
shutdown scripts

The installation procedure prompts you for the name of an
alternate root path. An alternate boot environment lets you
install NetBackup on a different file system.

For example, suppose that Host B’s root, usr, etc, tmp,
and var file systems are mounted on Host A as follows:

/alt, /alt/usr, /alt/etc, /alt/tmp, and /alt/var.

When you log in to Host A, you can specify /alt as the
alternate root environment and install NetBackup on Host
B.

This feature applies to NetBackup servers only and not
options or clients.

Solaris systems

For the platforms that support PBX, NetBackup versions
7.x install or update PBX when the client software is
installed.

If the computer where you install NetBackup does not
already have PBX and the platform supports it, the
installation script installs PBX.

If PBX already exists on the computer, the installation script
performs one of the following tasks:

■ Updates the existing version if it is older than the version
that is included with 7.5.

■ Does not update PBX if the existing version is the same
or later than the version that is included with 7.5.

Note: If you upgrade from NetBackup 6.0 or 6.5, PBX may
not upgrade correctly. If the PBX upgrade is not successful,
use the ICS disk from your 6.0 or 6.5 package to remove the
older version. For complete details, see the Infrastructure
Core Services Installation Guide for those NetBackup
versions.

PBX

About mounting the NetBackup software media
Use the examples in the following table as guidelines when you mount NetBackup
DVDs. Check with your hardware vendor to see if you may need to use other flags
or options.
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Table 3-1 Flags and options for mounting NetBackup DVDs

DefinedFlags or options

Specifies the type of file system to mount.-v, -t, -F

Translates the file names properly if required.-o

Specifies that you want to mount the DVD for reading.-r

Specifies the name of the DVD drive.device_path

Specifies the directory where you want to mount the DVD.mount_point

See “Mounting NetBackup software media on AIX systems” on page 54.

See “Mounting NetBackup software media on FreeBSD systems” on page 55.

See “Mounting NetBackup software media on HP-UX systems” on page 55.

See “Mounting NetBackup software media on Linux systems” on page 57.

See “Mounting NetBackup software media on Solaris systems” on page 57.

Mounting NetBackup software media on AIX systems
For AIX systems, you must create a mount point before you mount the DVD.

The following procedure describes how to mount the DVD with either the smitty
or the manual method.

To mount the DVD on AIX systems

1 Log in as root.

2 Mount the DVD with one of the following methods:

■ smitty

smitty cdrfs

OR

smitty mountfs

■ Manually
Create the mount point (for example, mkdir /cdrom), and then run the
mount command, as follows:

mount -v cdrfs -r device_path mount_point
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For example, the following command mounts the DVD manually with
/cdrom as the mount point and /dev/cd0 as the device path:

mount -v cdrfs -r /dev/cd0 /cdrom

Mounting NetBackup software media on FreeBSD systems
For FreeBSD systems, you must create a mount point before you mount the DVD.

The following procedure describes how to mount the DVD.

To mount the DVD on FreeBSD systems

1 Log in as root.

2 Create the mount point. For example, mkdir /cdrom.

3 Mount the DVD, as follows:

mount -r -t cd9660 device_path mount_point

For example, the following command mounts the DVD using /cdrom as the
mount point and /dev/acd0c as the device path:

mount -r -t cd9660 /dev/acd0c /cdrom

Mounting NetBackup software media on HP-UX systems
To mount and unmount the DVD on HP-UX varies, depending on the version of
the operating system you are running.

Use one of the following mounting procedures as is appropriate for your operating
system version.

To mount the DVD on HP-UX operating systems earlier than 11.23

1 Log in as root.

2 Create the mount point. For example, mkdir /cdrom.
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3 Start the PFS daemons, as follows:

nohup pfs_mountd &

nohup pfsd &

4 Mount the DVD, as follows:

pfs_mount -o xlat=unix device_path mount_point

To find the device path, you can run ioscan -fn.

For example, the following command mounts the DVD using /cdrom as the
mount point and /dev/rdsk/c3t2d0 as the device path:

pfs_mount -o xlat=unix /dev/rdsk/c3t2d0 /cdrom

To unmount the DVD on HP-UX operating systems earlier than 11.23

1 Unmount the DVD, as follows:

pfs_umount mount_point

For example, the following command unmounts a DVD that used /cdrom as
the mount point:

pfs_umount /cdrom

2 Stop the following processes with the kill command:

pfs_mountd

pfsd

pfs_mountd.rpc

pfsd.rpc

To mount the DVD on HP-UX 11.23 or later operating systems

1 Log in as root.

2 Mount the DVD, as follows:

mount -F cdfs device_path mount_point
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To unmount the DVD on HP-UX 11.23 or later operating systems

1 Unmount the DVD, as follows:

umount mount_point

2 Remove the DVD from the drive.

Mounting NetBackup software media on Linux systems
For Linux systems, you must create a mount point before you mount the DVD.

The following procedure describes how to mount the DVD.

Note: The RedHat automounter may mount the DVD with insufficient rights. If
the installation from the DVD fails with the message Permissiondenied, use the
following steps to mount the DVD manually.

To mount the DVD on Linux systems

1 Log in as root.

2 Create the mount point. For example, mkdir /cdrom.

3 Mount the DVD, as follows:

mount device_path mount_point

For example, the following command mounts the DVD using /cdrom as the
mount point and /dev/cdrom as the device path:

mount /dev/cdrom /cdrom

Mounting NetBackup software media on Solaris systems
For Solaris systems, use Volume Manager to mount the DVD.

The following procedure describes how to mount the NetBackup software media.

To mount the DVD on Solaris systems

1 Log in as root.

2 If Volume Manager (vold) is running, the DVD mounts automatically.

If vold is not running, start it up as follows:

/usr/sbin/vold &

57Installing server software
About mounting the NetBackup software media



InstallingNetBackupmaster server software onUNIX
The master server manages backups, archives, and restores. The master server
is where the NetBackup catalog resides which includes the internal databases that
contain information about NetBackup configuration and backups.

Use the following guidelines for a new master server installation:

Designate the computer that you want to be the master
server and install the master server software on that
computer first.

Designate master server

By default, the installation script installs the Enterprise
Media Manager (EMM) Server software on the master server.
This configuration is preferred and is the most efficient.

Note: Although the EMM server can be located on a media
server, Symantec recommends that you keep it on the
master server. To locate the EMM on a media server requires
that you perform another procedure. After all NetBackup
server software (master and media) is installed, you must
move the NetBackup database and the EMM server to the
designated media server. For complete details, refer to the
NetBackup Administrator's Guide for UNIX and Linux,
Volume I. See the section "Moving the NetBackup Database
from one host to another".

EMM server

During master server installation, you must enter a
NetBackup product license key. You must also enter license
keys for any additional NetBackup product options or agents
that are used on the server or its clients. These additional
license keys must be entered on the master server.

If you add, delete, or make and save any license key updates
in the NetBackup-Java Administration Console, you must
restart the console.

For more information on how to administer NetBackup
licenses, see theNetBackupAdministrator’s Guide, Volume
I.

License keys

Starting with NetBackup 7.0, this platform is not supported
as a master server or as a media server that contains the
EMM server. It is only supported as a true media server (no
EMM) or a true client.

HP PA-RISC
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Starting with NetBackup 7.0, these platforms are no longer
supported for use as a master server or as a media server.
These platforms are only supported as true clients.

Linux SUSE and Linux Red
Hat Itanium

Starting with NetBackup 7.0.1, these platforms are
supported for use as media servers only.

IBMzSeries RedHat and
IBMzSeries SUSE

To install NetBackup master server software

1 Log in to the server as root.

2 Use one of the following methods to start the installation script:

■ Insert the NetBackup Server DVD for the
appropriate platform into the drive.

Check the DVD label to identify its contents.

See “About the NetBackup media kit” on page 28.

■ If necessary, mount the DVD.

See “About mounting the NetBackup software
media” on page 53.

■ Enter the following command:

cd_directory/install

The cd_directory is the path to the directory where
you can access the DVD.

DVD

■ Navigate to the location where the installation
images reside.

■ Enter the following command:

./install

ESD images (downloaded
files)

3 When the following message appears, press Enter to continue:

Installing NetBackup Server software.

Do you wish to continue? (y/n) [y]

4 For the NetBackup installation location and the option to upload the
installation and the platform information to Symantec, enter the appropriate
platform information as follows:
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■ NetBackup is set up by default to install to the running root
environment.

To install to the running root environment, press Enter.

To change the installation location, type n and press Enter.
Then enter the appropriate destination.

■ When the following question appears, press Enter to accept
the default (y) or type n and press Enter:

Participate in the NetBackup Product Improvement
Program? (y/n) [y]

■ When the following question appears, press Enter to accept
the default (y):

NetBackup and Media Manager binaries will be installed
in /opt/openv and a link will be created from /usr/openv
to opt/openv, if it does not exist.
Is this okay? (y) [y, n,?, q]

To accept the default (y), press Enter.

To change the installation location, type n and press Enter.
Then enter the appropriate destination.

For Solaris
systems:

■ When the following question appears, press Enter to accept
the default (y) or type n and press Enter:

Participate in the NetBackup Product Improvement
Program? (y/n) [y]

■ When the following question appears, press Enter to accept
the default (y).

The NetBackup and Media Manager software is built
for use on <platform> hardware. Do you want to install
NetBackup and Media Manager files? [y,n] (y)

■ When the following question appears, select where to install
NetBackup and Media Manager software:

NetBackup and Media Manager are normally
installed in /usr/openv.
Is it OK to install in /usr/openv? [y,n] (y)

To accept the default (y), press Enter.

To change the installation location, type n and press Enter.
Then enter the appropriate destination.

For all other UNIX
systems:
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5 Enter the NetBackup Server or Enterprise Server license key.

6 Type y, then follow the prompts to add license keys for other NetBackup
options and agents.

Although you can add license keys later, you should enter them now. If you
add any license keys later through the NetBackup-Java Administration
Console, you must restart the console.

7 After all license keys are entered, type q to quit the License Key Utility and
complete the server software installation.

8 Verify or enter the correct computer name when prompted by the following
message:

Installing NetBackup Enterprise Server version: 7.5

If this machine will be using a different network interface than

the default (name), the name of the preferred interface

should be used as the configured server name. If this machine

will be part of a cluster, the virtual name should be used as the

configured server name.

The domainname of your server appears to be "domain". You

may choose to use this domainname in your configured NetBackup

server name, or simply use "name" as the configured

NetBackup server name.

Would you like to use "name.domain" as the configured NetBackup server

name of this machine? [y, n] (y)

■ To accept the displayed (default) name, press Enter.

■ To change the displayed (default) name, type n and enter the name that
you want.

■ For a clustered NetBackup server, enter the virtual name for the NetBackup
server and not the actual local host name.

9 Identify or verify the master server by answering the following question when
it appears:

Is <name> the master server? [y, n] (y)

■ To accept the displayed name (which is the name that you identified in
the previous step), press Enter.

■ If you entered a virtual name for the server in the previous step, the
installation script presents the following question:

Is this server part of a cluster installation?
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If the answer is yes, press y and answer the series of cluster configuration
questions that appear.
If the answer is no, press n.

10 Identify whether there are any media servers for this master server by
answering the following question when it appears:

Do you want to add any media servers now? [y, n] (n)

■ If there are no media servers for this master server, press Enter and
proceed to the next step.

■ If there are media servers for this master server, type y and enter the
name of each media server.
When you enter the media server names, you must enter the computer
name and the domain name. For example:

alpha.min.symantec.com

Where alpha is the computer name and min.symantec.com is the domain
name.
The media server names that you enter here are added to the bp.conf file
on the master server, automatically. After you install the media server
software later, the master server can then communicate with the media
servers immediately.

■ To add a media server to an existing and an operational NetBackup
environment, you cannot use the procedures in this guide. For complete
details on how to add a media server to an existing and an operational
NetBackup environment, see theNetBackupAdministrationGuide,Volume
II.

11 When the following message appears, identify the name of the EMM server.

NetBackup maintains a centralized catalog (separate from the

image catalog) for data related to media and device

configuration, device management, storage units, hosts and host

aliases, media server status, NDMP credentials, and other

information. This is managed by the Enterprise Media Manager

server.

Enter the name of the Enterprise Media Manager (default: <name>)

■ To accept the displayed (default) master server name and install the EMM
server on the master server, press Enter.

■ On a clustered master server, enter the virtual name of the master server.

Installing server software
Installing NetBackup master server software on UNIX

62



Symantec does not support installing the EMM on an NFS-mount.

12 Answer the following question when it appears:

Do you want to start the NetBackup job-related processes so backups and

restores can be initiated? [y, n] (y)

■ If you have (or want to have) a clustered NetBackup server, type n.

■ For non-clustered installations, press Enter to accept the default answer
(y) and start the NetBackup processes and the EMM server.
You must start these processes now because the EMM server must be
running when you install any media servers later.

13 For a clustered NetBackup master server, repeat these steps on every node
on which you want to run NetBackup.

Continuing with NetBackup software installation
After you have installed the master server software, you are ready to install media
server software or client software depending on your environment.

■ If you have media servers in your system, you are ready to install media server
software.
See “Installing NetBackup media server software on UNIX” on page 63.

■ If there are no media servers in your environment, you are ready to install
client software on client machines.

■ See “Installing UNIX clients locally” on page 132.

■ To install client software on clients from the master server location
(recommended), you must first install the client type software on the master
server.
See “Installing client type software on a master server” on page 68.

Installing NetBackup media server software on UNIX
This section describes how to install a new NetBackup media server. Use this
information to install the server software on a computer with no existing version
of NetBackup.

Media server software manages the robotic and the storage devices within your
NetBackup environment.

After you have installed the master server and the EMM server software, you are
ready to install media server software on media server computers.
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Use the following guidelines when you install new media servers:

Designate the computers that you want to be media servers
and install the media server software on them.

Designate media servers

New or initial NetBackup 7.x media servers cannot be
installed as clusters. However, existing media servers with
NetBackup 6.x that are clustered can be upgraded to
NetBackup 7.x and still remain clustered.

Clusters

The EMM server must be installed and running before you
install media server software.

EMM server

When you install NetBackup media server software, you
must enter a NetBackup product license key. You must also
enter license keys for any additional NetBackup product
options or agents that are used on the server or its clients.
These additional license keys must be entered on each media
server.

For more information on how to administer NetBackup
licenses, see theNetBackupAdministrator’sGuide forUNIX
and Linux, Volume I.

Note: If you make and save any license key changes in the
NetBackup-Java Administration Console, you must restart
the console.

License keys

Starting with NetBackup 7.0.1, these platforms are
supported for use as media servers only.

IBMzSeries RedHat and
IBMzSeries SUSE

To install NetBackup media server software

1 Log in to the server as root.

2 Use one of the following methods to start the installation script:

■ Insert the NetBackup Server DVD for the
appropriate platform into the drive.

Check the DVD label to identify its contents.

See “About the NetBackup media kit” on page 28.

■ If necessary, mount the DVD.

See “About mounting the NetBackup software
media” on page 53.

■ Enter the following command:

cd_directory/install

The cd_directory is the path to the directory where
you can access the DVD.

DVD
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■ Navigate to the location where the installation
images reside.

■ Enter the following command:

./install

ESD images (downloaded
files)

3 When the following message appears, press Enter to continue:

Installing NetBackup Server software.

Do you wish to continue? (y/n) [y]

4 For the NetBackup installation location and the option to upload the
installation and the platform information to Symantec, enter the appropriate
platform information as follows:

■ NetBackup is set up by default to install to the running root
environment.

To install to the running root environment, press Enter.

To change the installation location, type n and press Enter.
Then enter the appropriate destination.

■ When the following question appears, press Enter to accept
the default (y) or type n and press Enter:

Participate in the NetBackup Product Improvement
Program? (y/n) [y]

■ When the following question appears, press Enter to accept
the default (y):

NetBackup and Media Manager binaries will be installed
in /opt/openv and a link will be created from
/usr/openv to opt/openv, if it does not exist.
Is this okay? (y) [y, n,?, q]

To accept the default (y), press Enter.

To change the installation location, type n and press Enter.
Then enter the appropriate destination.

For Solaris
systems:
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■ When the following question appears, press Enter to accept
the default (y) or type n and press Enter:

Participate in the NetBackup Product Improvement
Program? (y/n) [y]

■ When the following question appears, press Enter to accept
the default (y).

The NetBackup and Media Manager software is built
for use on <platform> hardware. Do you want to install
NetBackup and Media Manager files? [y,n] (y)

■ When the following question appears, select where to install
NetBackup and Media Manager software:

NetBackup and Media Manager are normally
installed in /usr/openv.
Is it OK to install in /usr/openv? [y,n] (y)

To accept the default (y), press Enter.

To change the installation location, type n and press Enter.
Then enter the appropriate destination.

For all other UNIX
systems:

5 Enter the NetBackup Server or NetBackup Enterprise Server license key.

6 Type y, then follow the prompts to add license keys for other NetBackup
options and agents.

Although you can add license keys later, you should enter them now. If you
add any license keys later through the NetBackup-Java Administration
Console, you must restart the console.

7 After all license keys are entered, type q to quit the License Key Utility and
complete the server software installation.

8 Verify or enter the correct computer name when prompted by the following
message:

Installing NetBackup Enterprise Server version: 7.5

If this machine will be using a different network interface than

the default (name), the name of the preferred interface

should be used as the configured server name. If this machine

will be part of a cluster, the virtual name should be used as the

configured server name.

The domainname of your server appears to be "domain". You

may choose to use this domainname in your configured NetBackup
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server name, or simply use "name" as the configured

NetBackup server name.

Would you like to use "name" as the configured NetBackup server

name of this machine? [y, n] (y)

■ If the displayed (default) media server name is correct, press Enter.

■ If the displayed (default) media server name is not correct, type n and
enter the correct name.

9 Identify the master server that you have already installed, by answering the
following question when it appears:

Is <name> the master server? [y,n]

■ Type n and enter the fully qualified domain name of the master server.

■ If the master server is clustered, enter the virtual name of the master
server.

10 When the following message appears, identify the name of the EMM server.

Enter the name of the Enterprise Media Manager (default: <name>)

The master server name is displayed by default.

■ If you installed the EMM server on the master server, press Enter to accept
the displayed (default) name.
If you have a clustered master server, enter the virtual name for the master
server and not the actual local host name.

11 Repeat steps 1 through 10 to install media server software on any remaining
media servers.

About pushing client software from a master server
to clients

You can increase the speed of client installation by pushing the software from
the master server to the clients. This method eliminates the need for a local
installation at each client.

The following describes how to prepare your NetBackup environment for client
software installation from the master server.

■ Install the client type software on the master server. Be sure to install all of
the client types that pertain to your NetBackup configuration.
See “Installing client type software on a master server” on page 68.
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■ Before you can push client software from the master server, each client name
must be assigned to a NetBackup policy. Policies are created on the master
server.
When you create a policy, you must identify the policy type, which indicates
the operating system on the clients that are assigned to that policy. Without
a policy, the remote installation (or push) fails because the master server does
not know the operating system of the client.
For information on how to create NetBackup policies, refer to the NetBackup
Administrator’s Guide for UNIX and Linux, Volume I.

■ After the required policies are created, you can push client software from the
master server to the clients.
See “About remote installation methods for UNIX clients” on page 133.

Installing client type software on a master server
Client type software must be installed on the master server to perform the
following operations:

■ Assign clients to NetBackup policies so that those clients can be backed up.

■ Install (or push) client software from the master server to clients.
For each UNIX client type, the client installation script lets you install the
client software onto the master server. You can then install (or push) the client
software from the master server to the clients.

To install client type software on a master server

1 Log in to the server as root.

2 Use one of the following methods to start the installation script:

■ Insert the NetBackup UNIX Clients DVD into the
drive.

See “About the NetBackup media kit” on page 28.

■ If necessary, mount the DVD.

See “About mounting the NetBackup software
media” on page 53.

■ Enter the following command:

cd_directory/install

The cd_directory is the path to the directory where
you can access the DVD.

DVD
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■ Navigate to the location where the installation
images reside.

■ Enter the following command:

./install

ESD images (downloaded
files)

3 When the following message appears, press Enter to continue:

Installing NetBackup Client Software.

Do you wish to continue? (y/n) [y]

4 Select all of the client types that you want to install and follow the installation
prompts.

Installing NetBackup add-on products
After your initial installation is complete, you can install any other NetBackup
add-on products (such as language packages).

How to configure the window manager for the Java
Interface (NetBackup-Java compatible platforms)

Always set your window manager so that windows become active only when you
click inside the windows. Do not enable auto focus, where windows become active
if you move the mouse pointer over them. The NetBackup-Java interfaces do not
run properly with auto focus enabled.
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Installing alternative
administrative interfaces

This chapter includes the following topics:

■ About the NetBackup Remote Administration Console for Windows

■ About the NetBackup-Java Administration Console

About theNetBackupRemoteAdministrationConsole
for Windows

If your NetBackup server has no graphics display capabilities, you must install
an alternative administrative interface. It may also be desirable for various other
configurations, such as mixed environments that use the Windows and the UNIX
platforms.

Note: You can skip this section if you do not want or need to administer a
NetBackup server remotely from a Windows NetBackup client.

The NetBackup Remote Administration Console is an interface-only version of
NetBackup for Windows that you can use to administer NetBackup servers from
another computer. The computer that runs the NetBackup Remote Administration
Console does not require NetBackup software.

The following is a brief description of the NetBackup Remote Administration
Console operation:

■ The console lets you perform all NetBackup operations exactly like the
NetBackup Administration Console on a local Windows NetBackup server. You
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can create backup policies, manage volumes, view status, monitor tape drives,
and perform other operations.

■ The console displays the name of the server it administers, rather than a local
host name.

■ The console can only administer other NetBackup servers. It cannot act as a
master or a media server.

Installing the NetBackup Remote Administration Console
The NetBackup Remote Administration Console is supported on Windows Server
2003/XP, Windows Server 2008/Vista, and Windows Server 2008 R2/Windows 7.

Installation is a two-step process as follows:

■ Install the NetBackup Remote Administration Console.

■ Add the NetBackup Remote Administration Console host name to the server
list of the hosts that you want to administer.
You must also add the host names of the servers that you want to administer
to the server list on the host where you install the remote console.
The following table shows an example of the required server list entries for
each host. RAC1 refers to the Remote Administration Console.

Required server list entriesHost name

RAC1Master1

RAC1Media1

RAC1Media2

Master1, Media1, Media2RAC1

To install the NetBackup Remote Administration Console

1 On the computer where you want to install the NetBackup Remote
Administration Console, start the NetBackup Installation Wizard with one
of the following methods:

■ DVD media
Insert the NetBackup for Windows DVD in the drive. If Autorun is disabled,
navigate to the DVD drive and run Browser.exe.

■ ESD images (downloaded files)
Navigate to the directory where the images reside and run Browser.exe.

2 On the initial screen, click Installation.
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3 On the Installation screen, click Server Software Installation.

4 On the Welcome screen, review the content and click Next.

5 On the LicenseAgreement screen, accept the terms of the license agreement
and click Next.

6 On the Installation Type screen, select Install to this computer only, click
Typical, and then click Next.

7 On the NetBackup License Key and Server Type screen, select NetBackup
RemoteAdministrationConsole. You do not need a license key to install the
Remote Administration Console.

8 On the NetBackupSystemNames screen, provide the following information:

Enter the name of the local computer where you want
to install the remote console. (The name should appear
by default.)

Client Name

Enter the name of the NetBackup master server. (If
NetBackup master server software is installed on this
computer, the name should appear by default.)

Master Server

Enter the names of any additional NetBackup servers
that you want to allow access to this server. To enter
more than one name, separate each name with a
comma or press Enter after you enter each name.

Additional Servers

9 On the Ready to Install the Program screen, review the summary of your
selections. Then, click Install.

10 After the installation completes, do the following:

■ Click View Log to review the installation details.

■ Click Finish.
If you clicked the box next to LaunchNetBackupAdministrationConsole
now, the Remote Administration Console appears. If you did not click the
box, start the console by selecting Start > Programs > Symantec
NetBackup > NetBackup Administration Console.
This action starts the console on the local host, not on any remote host.

11 Add the required host names to the server lists of all hosts.

See “Configuring server lists for the NetBackup Remote Administration
Console” on page 74.
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Configuring server lists for the NetBackup Remote Administration
Console

The following methods are available to configure server lists for the NetBackup
Remote Administration Console:

■ Use the NetBackup Administration Console

■ On UNIX servers, edit the bp.conf file.

■ On Windows servers, edit the system registry.

To configure server lists for the NetBackup Remote Administration Console by
using the NetBackup Administration Console

1 On the NetBackup Administration Console in the left pane, click Host
Properties > Master Servers.

2 In the Master Servers window in the right pane, right-click the name of the
host server and select Properties.

3 In the Master Server Properties window, click the Servers icon from the
tree in the left pane.

4 In the Servers window, click Add.

5 Enter the name of the host that is to run the NetBackup Remote
Administration Console.

6 Click Add. The name of the host appears in the Additional Servers list.

7 Click Close and OK.

To configure server lists for the NetBackup Remote Administration Console by
editing the bp.conf file on UNIX servers

1 Log in to the master server as root.

2 Edit the following file:

/usr/openv/netbackup/bp.conf.

3 At the end of the SERVER = lines, add the following line:

SERVER = Remote-Administration-Console-machine-name

The Remote-Administration-Console-machine-name is the name of the
computer where you installed the NetBackup Remote Administration Console.

To configure server lists for the NetBackup Remote Administration Console by
editing the system registry on Windows servers

1 Log on to the master server as the administrator.

2 Click Start > Run....
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3 Enter regedit.exe and click OK.

4 In the Registry Editor window, locate the following file:

HKEY_LOCAL_MACHINE\SOFTWARE\VERITAS\NetBackup\CurrentVersion\Config

5 In the right pane, double-click on Server.

6 In the Edit Multi-String window, enter the name of the Remote
Administration Console host and click OK.

7 Close the Registry Editor window.

Adding remote servers to administer from an existing NetBackup
Remote Administration Console

If you have an existing NetBackup Remote Administration Console installed and
you want to add a remote master server to administer, use this procedure.

To add a remote server to administer from an existing NetBackup Remote
Administration Console

1 Log on to the host where the NetBackup Remote Administration Console is
installed, and open the console.

2 In the left pane of the NetBackup Remote Administration Console, select Host
Properties > Master Server.

3 In the Master Servers window in the right pane, right-click the name of the
host server and select Properties (Read/Write).

4 In the Master Server Properties window, click the Servers tab.

5 In the Global Operations field, in the Add to all lists field, enter the host
name. Make sure that you enter the name of the host that is to run the
NetBackup Remote Administration Console.

6 Click the + icon (the name of the host appears in the AdditionalServers list),
then click OK.

About the NetBackup-Java Administration Console
The NetBackup-Java Administration Console can be used to administer one or
more UNIX or Windows NetBackup servers. It provides all of the standard
NetBackup server interfaces. The console can be used to create backup policies,
manage volumes, view status, monitor tape drives, and other operations.

On Java-capable UNIX hosts (servers and clients), this console is installed
automatically when you install NetBackup.
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On Windows hosts, this console must be installed separately.

Note: You can skip this section if you do not want or need to administer a
NetBackup server remotely from a Windows NetBackup client.

See “Installing the NetBackup Java Administration Console for version 7.5 on
Windows” on page 76.

Installing the NetBackup Java Administration Console for version 7.5
on Windows

Use the following guidelines when you install version 7.5 of the console:

■ Install the console from the NetBackup DVD for Windows or from the ESD
(downloaded) files.

■ Any computer that runs the console should have at least 512 MB of physical
memory.

To install version 7.5 of the NetBackup Java Administration Console on Windows

1 On the computer where you want to install the console, do one of the following:

■ Insert the appropriate DVD that contains the NetBackup software.
On Windows systems with Autorun enabled, the installation starts
automatically.
On Windows systems with Autorun disabled, navigate to the DVD directory
and run Browser.exe.

■ Navigate to the location where the downloaded files reside and run
Browser.exe.

2 On the initial screen, select Installation.

3 On the Installation screen, select Java Windows Administration Console
Installation.

4 On the Welcome screen, review the content and click Next.

5 On the License Agreement screen, accept the agreement and click Next.

6 On the NetBackup Installation Type screen, select Install to this computer
only and Typical. Then, click Next.

7 On the ReadytoInstalltheProgram screen, review the Installation Summary
and click Install.
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8 On the Installation Complete screen, click Finish.

9 To open the console, click Start > Programs > Symantec NetBackup >
NetBackup Java version 7.5.

In a site that contains multiple master servers, you can configure the systems so
that one NetBackupAdministrationConsole can access remote servers. Indicate
a remote server by using one of the following methods:

■ Use the File > Change Server menu command.

■ Use the NetBackup-Java Administration Console. Indicate a remote system
upon NetBackup login.

Note:To log in to any NetBackupAdministrationConsole, your login credentials
must be authenticated from the connecting master or media server. This is true
whether or not NetBackup Access Control (NBAC) is in use.

The NetBackup Administration Console on Windows and the NetBackup-Java
Administration Console on UNIX are backward-compatible in the following
situations:

■ From the console of an x.x.x (double-dot) or x.x.x.x (triple-dot) release to the
console of any release that shares the fist and second digits.
For example, a NetBackup 7.0.1 console can administer a NetBackup 7.0 master
server. However, a NetBackup 7.1 console (a single-dot release) cannot
administer a 7.0 or 7.0.1 master server because the second digits are not the
same. Figure 4-1 shows examples of each.

■ The NetBackup-Java Administration Console on UNIX offers an exception
when the -r option is used with the jnbSA command to start the console.

The -r option lets a x.x NetBackup-Java Administration Console connect to
another UNIX master server that is several versions earlier, regardless of
whether the second digit is the same.
For example, a 7.5 NetBackup-Java Administration Console can connect to a
NetBackup master server at 7.1, 7.0, 6.5, or 6.0. Figure 4-2 shows examples of
back-level console support.
Use the -r option to launch the console on the UNIX system as follows:

./jnbSA -r release_version

For example, to connect to a 7.0 master server from a 7.5 NetBackup-Java
Administration Console, enter the following on the 7.5 master server to start
the 7.0 console:
./jnbSA -r 7.0

If no -r option is specified, the default is the current NetBackup version.
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Figure 4-1 Examples of supported and unsupported back-level console
configurations

Yes No Yes

7.1.0.3

No

7.0

7.0.1 7.0.1

7.0 7.5

7.1.0.1

7.1

Figure 4-2 Examples of additional NetBackup-Java Administration Console
back-level support using the jnbSA -r option

7.5

Yes

6.0

7.1

6.5

Yes

See the NetBackup Installation Guide for information about installing earlier
versions of the NetBackup-Java Administration Console.

Methods for administering multiple versions of NetBackup
servers
Table 4-1 describes the available methods to administer NetBackup 7.5 with an
earlier version console. The order of the listed methods does not imply any
preference.

Table 4-1 Methods for administering multiple versions of NetBackup servers

NotesMethod

The earlier versions available in a
release are all of those supported in a
mixed version environment with the
current release. For example, all
versions back to and including the last
major release.

In the NetBackup 7.5 release, the 7.1,
7.0, 6.5.x, and the 6.0.x console versions
are available.

Earlier versions of the NetBackup-Java
Administration Console on UNIX platforms

Earlier versions of the NetBackup-Java
Administration Console on Windows platforms
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Table 4-1 Methods for administering multiple versions of NetBackup servers
(continued)

NotesMethod

From a Windows computer, you can
access the Java Windows
Administration Console on a UNIX
NetBackup server by using connectivity
software applications.

Remote display-back from UNIX servers

Use the appropriate NetBackup-Java
Administration Console on the
NetBackup server with the earlier
version of the console.

At the console on the NetBackup server

Installing multiple versions of the NetBackup-Java
Administration Console on Windows
To install multiple versions of the NetBackup interface in a mixed version
environment, note the following restrictions and guidelines:

Only the most recent version of the NetBackup-Java
Administration Console can be updated (or patched).

Updates

The NetBackup-Java Capabilities Authorization
configuration file (auth.conf), must always be located in
install_path\java. For example, C:\Program
Files\Veritas\java. The file must exist there regardless
of how many versions of the console are installed, or in
which directories they are installed.

The file is only used for administering NetBackup on this
Windows host, and default settings exist if the file is not
present. For more information about these defaults, see the
section "Authorizing NetBackup-Java users" in the
NetBackup Administrator’s Guide for Windows, Volume I.

auth.conf file

You must install each Java console version to a different
folder.

Console version location

To install earlier versions of the NetBackup-Java Administration Console

1 Insert the appropriate version NetBackup Windows installation media with
the NetBackup-Java Administration Console that you want to install.

2 Select one of the following consoles, based on the NetBackup version:
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■ For NetBackup 6.0 versions, select NetBackup Installation and click
Install Java Administration Console. Select whether you want to install
the 32-bit or the 64-bit console.

■ For NetBackup 6.5 versions, select NetBackup Installation and click
Install JavaWindowsAdministrationConsole. Select whether you want
to install the 32-bit or the 64-bit console.

■ For NetBackup 7.0 and 7.1 versions, select Installation and click Java
Windows Administration Console Installation.

3 If a different version of the Java console has already been installed, specify
a new folder location to prevent overwriting the earlier installation.

For example, specify C:\Program Files\Veritas\nbjava65 for version 6.5
Java consoles.

4 To complete the installation, click Finish.

Removing earlier versions of the NetBackup-Java
Administration Console on Windows
In some cases, you can remove earlier versions of the NetBackup-Java
Administration Console by using the Add/Remove Programs feature. You can
use this method if the version that you want to remove appears in the list of
programs.

If the version that you want to remove does not appear in the list of programs,
you must manually remove it. Use the following procedure.

Tomanually remove earlier versions of theNetBackup-Java Administration Console

1 Remove the folder where the earlier version NetBackup-Java Administration
Console is installed.

2 Remove the appropriate menu item from the Start>Programs>NetBackup
menu.

3 Remove any relevant desktop shortcuts.

Installing alternative administrative interfaces
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Upgrading server and client
software

This chapter includes the following topics:

■ Requirements for upgrading UNIX servers to NetBackup 7.5

■ Upgrading server software from versions 6.x or 7.x to 7.5

■ Upgrading clients after servers are upgraded

■ Completing your system update after an upgrade

■ Automatic file changes from an upgrade

Requirements for upgrading UNIX servers to
NetBackup 7.5

Before you upgrade, refer to the NetBackup Release Notes for version 7.5 for
complete details about the changes that may affect how to upgrade your NetBackup
environment.

Warning: To help ensure a successful upgrade to NetBackup 7.5, please proceed
immediately to the following NetBackup 7.5 Upgrade Portal for complete upgrade
details: http://www.symantec.com/docs/TECH74584
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Warning: If you currently use NetBackup versions 7.0.x and want to upgrade a
Solaris SPARC media server that hosts a media server deduplication pool, an
updated version of the pduninstall.sh script is required. The new script must
be installed before you upgrade to NetBackup 7.5. Please see the following Technote
on the Symantec Support Web site to download the updated script:
http://symantec.com/docs/TECH146243. If you upgrade before this file is updated,
the Technote also describes the necessary steps that you must follow to fix any
related problems.

Note: If you currently use NetBackup 6.x and plan to upgrade to version 7.5, be
aware that NetBackup versions 7.0 and 7.1 contained many changes and
enhancements. Before you upgrade from any 6.x version to 7.5, you should refer
to theNetBackup Release Notes for versions 7.0 and 7.1 for complete details. You
can also refer to the following topics for a summary of changes in NetBackup 7.0
and 7.1: See “ About changes in NetBackup 7.1” on page 21. and See “About changes
in NetBackup 7.0” on page 23.

The following describes the general requirements for UNIX server upgrades:

■ Direct upgrades to NetBackup 7.5

You can upgrade directly to NetBackup 7.5 from versions
6.x, 7.0, or 7.1.

This installation guide includes the procedures for these
upgrades.

■ Upgrades from 5.x versions

If you currently use NetBackup 5.x versions, you cannot
upgrade directly to 7.5. You must first upgrade to
NetBackup 6.0 or 6.5. Symantec recommends that you
upgrade to 6.5.

An upgrade guide is posted on the upgrade portal at the
following location:

http://www.symantec.com/docs/TECH52785.

After you upgrade to 6.5, you can upgrade to 7.5.

Supported upgrade paths

Before you proceed with any upgrade procedure, always
back up your existing NetBackup database. If an error occurs
during the upgrade, you can roll back to the previous version
and still retain your information from the database backup.

Back up databases
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Many of the NetBackup server installation requirements
also apply to NetBackup upgrades. Review these
requirements before you upgrade.

See “About NetBackup server installation requirements for
UNIX systems” on page 30.

Review installation
requirements

When you perform an upgrade, a master server cannot be
changed to a media server. To make this change, you must
first remove the earlier version of NetBackup, then install
the new version.

Converting a master server
to a media server

For NetBackup Enterprise upgrades, you cannot convert an
existing non-failover server to a highly available failover
NetBackup server.

Converting a non-failover
server to a NetBackup
failover server

Make sure that the NetBackup version on each server is at
least equal to the version on any clients. Earlier software
versions on servers can encounter problems with later
software versions on clients.

Version support between
servers and clients

Add-ons must be at the same version as the NetBackup
server or the client where the add-on is installed.

Add-on product versions

Starting with NetBackup 7.1, NetBackup Access Control
(NBAC) is installed with NetBackup. If you currently use
NBAC in NetBackup versions 6.x through 7.0.1, a separate
upgrade is no longer required. An upgrade to version 7.1 or
later automatically migrates all NBAC files from a shared
location to a location within NetBackup.

NetBackup Access Control
(NBAC)

If you have NetBackup clients that are unsupported for
NetBackup 7.x, you may encounter problems with new
features in this release. If you do not plan to upgrade these
earlier version clients, move them to a separate policy.

Conflicts with older clients
and new features

Ensure that the gzip and the gunzip commands are
installed on the local system. The directories where these
commands are installed must be part of the root user’s path
environment variable setting.

gzip and gunzip locations

83Upgrading server and client software
Requirements for upgrading UNIX servers to NetBackup 7.5



An upgrade to NetBackup 7.5 overwrites the nblog.conf
file with a new file and resets all logging levels to their
default values. If you changed any logging level values from
their default in your current NetBackup environment, you
must change them after the upgrade.

Upgrades to NetBackup 7.5 also reset the following features:

■ Logging Level

This feature was introduced in NetBackup 6.0 GA.
Upgrading to 7.5 resets this feature to its default
(DebugLevel=1 and DiagnosticLevel=6).

To change the Logging Level to the desired setting after
you upgrade, refer to the NetBackup Administrator’s
Guide, Volume I.

■ LogRecycle

This feature was introduced in NetBackup 6.0 MP4.
Upgrading to 7.5 resets this feature to False (off).

To change LogRecycle to the desired setting after you
upgrade, refer to theNetBackupTroubleshootingGuide.
You should also refer to the information at the following
Website:

http://www.symantec.com/docs/TECH44292

nblog.conf file updates

The following describes requirements for NetBackup server upgrades that are
specific to certain configurations:

Starting with NetBackup 7.0, NOM has been replaced with
OpsCenter. The new name retains the same functionality
as NOM and includes additional features.

All NOM 6.0 MPx and 6.5.x versions can be upgraded to
OpsCenter (NetBackup 7.x).

NetBackup Operations
Manager (NOM)
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The installation procedure prompts you for the name of an
alternate root path. This path is used in an alternate boot
environment that lets you install NetBackup on a different
file system.

For example, suppose that Host B’s root, usr, etc, tmp,
and var file systems are mounted on Host A as follows:

/alt, /alt/usr, /alt/etc, /alt/tmp, and /alt/var.

When you log in to Host A, you can specify /alt as the
alternate root environment and install NetBackup on Host
B.

This feature applies to NetBackup servers only and not
options or clients.

Solaris systems
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■ Refer to the NetBackup Clustered Master Server
Administrator’s Guide for cluster installation
prerequisites and notes, specific to your cluster
environment. This installation guide describes cluster
installation, but may not provide details for your
particular configuration.

■ An existing non-failover NetBackup server cannot be
converted to a highly available failover NetBackup
server.

■ Before you upgrade, you must have the cluster
frameworks installed, configured, and started.

■ Cluster environments are only supported with NetBackup
Enterprise Server.

■ The name that you enter during the upgrade for the
NetBackup server must be the virtual server name, not
the actual local host name.

■ Make sure that each node in the cluster where you install
NetBackup can run the rsh command or its equivalent.
(On HP-UX, the command is remsh). Starting with
NetBackup 7.5, you can also use the ssh command

The root user must be able to perform a remote login to
each node in the cluster without entering a password.
This remote login is necessary for installation and
configuration of the NetBackup server and any
NetBackup options. After installation and configuration
are completed, it is no longer required.

■ The virtual server name must be defined by using DNS,
NIS, or /etc/hosts. The IP address is defined at the
same time. (The virtual name is a label for the IP
address.)

■ The CLUSTER_NAME must be exactly the same in each
bp.conf configuration file. This requirement ensures
that the device configuration information for each
cluster node in the EMM database is stored properly.
Otherwise, the upgrade may not detect all of the cluster
nodes.

Clustered environments

Allowing for reinstallation of earlier versions of NetBackup
If you ever intend to reinstall a previous version of NetBackup after you have
performed an upgrade, backups are essential. If you need to reinstall, these backups
contain your most recent data.

Upgrading server and client software
Requirements for upgrading UNIX servers to NetBackup 7.5

86



Note: For clustered environments, you cannot reinstall an earlier version of
NetBackup.

To allow for reinstalling earlier versions of NetBackup

1 Back up all databases (media, volume, configuration, device) and catalogs on
the master and the remote media servers.

2 Back up all NetBackup patches, scripts, and the bp.conf entries that are
specific to the earlier NetBackup version.

You do not have to upgrade your clients at this time; only the master and the
remote media servers.

About the upgrade order for NetBackup 7.5
If you use NetBackup OpsCenter, you must first upgrade those product components
before you upgrade to NetBackup 7.5. Upgrading OpsCenter first helps to ensure
that it can interact with the new features in NetBackup 7.5. For complete
instructions about how to upgrade NetBackup OpsCenter, see the NetBackup
OpsCenter Administrator's Guide.

The following describes the order in which to upgrade all of these products. If you
do not use NetBackup OpsCenter, upgrade NetBackup as described in the last step.

Upgrade OpsCenter Agent.Step 1

Upgrade OpsCenter Server.Step 2

Upgrade OpsCenter View Builder.Step 3

Upgrade your NetBackup environment in the following order:

■ Back up the current NetBackup databases.

■ Upgrade master servers.

■ Upgrade media servers.

■ Upgrade NetBackup Remote Administration Consoles.

■ Upgrade clients.

■ Upgrade any installed NetBackup add-on products (such as
language packs).

Note: If your current NetBackup environment uses a remote EMM
(an EMM installed on a media server), you must upgrade this server
first. Once you upgrade the remote EMM, you must upgrade all master
servers that communicate with it. NetBackup does not support the
use of a later version EMM server with an earlier version master server.

Step 4

87Upgrading server and client software
Requirements for upgrading UNIX servers to NetBackup 7.5



The installation process automatically searches to determine if an earlier
NetBackup version exists on your system. The presence of an existing version
dictates that you are about to perform an upgrade.

Before you proceed with any upgrade, be sure to review the upgrade requirements.

See “Requirements for upgrading UNIX servers to NetBackup 7.5” on page 81.

See “About NetBackup mixed version support” on page 26.

See “About NetBackup server installation requirements for UNIX systems”
on page 30.

Upgrading server software from versions 6.x or 7.x
to 7.5

Before you begin an upgrade, Symantec recommends that you review the
NetBackup Release Notes document that is included with your media kit or the
electronic product image files. This document describes important changes in
NetBackup 7.5 that you should be familiar with before you upgrade.

Before you begin any upgrade to NetBackup 7.5, refer to the following topics to
help you prepare and plan for the upgrade:

See “About image metadata migration after upgrades to NetBackup 7.5” on page 15.

See “Planning for image metadata migration after an upgrade to NetBackup 7.5”
on page 19.

Caution: To help ensure a successful upgrade to NetBackup 7.5, please visit the
following NetBackup 7.5 Upgrade Portal for complete upgrade details:
http://www.symantec.com/docs/TECH74584

Warning: If you currently use NetBackup versions 7.0.x and want to upgrade a
Solaris SPARC media server that hosts a media server deduplication pool, an
updated version of the pduninstall.sh script is required. The new script must
be installed before you upgrade to NetBackup 7.5. Please see the following Technote
on the Symantec Support Web site to download the updated script:
http://symantec.com/docs/TECH146243. If you upgrade before this file is updated,
the Technote also describes the necessary steps that you must follow to fix any
related problems.
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Note: If you currently use NetBackup 6.x and plan to upgrade to version 7.5, be
aware that NetBackup versions 7.0 and 7.1 contained many changes and
enhancements. Before you upgrade from any 6.x version to 7.5, you should refer
to theNetBackup Release Notes for versions 7.0 and 7.1 for complete details. You
can also refer to the following topics for a summary of changes in NetBackup 7.0
and 7.1: See “ About changes in NetBackup 7.1” on page 21. and See “About changes
in NetBackup 7.0” on page 23.

Remember that starting with NetBackup 7.1, NetBackup Product Authentication,
and Authorization (NetBackup Access Control) is included and installed with
NetBackup. A valid license is still required to enable the product and configuration
is also required to use the feature.

The following information is a reminder of major changes in NetBackup 7.0 that
affect upgrades:

Starting with NetBackup 7.0, this platform is not supported
as a master server or as a media server that contains the
EMM server. It is only supported as a true media server (no
EMM) or a true client.

HP PA-RISC

Starting with NetBackup 7.0.1, these platforms are
supported for use as media servers only.

IBMzSeries RedHat and
IBMzSeries SUSE

VSM has reached its end of life and is not supported in
versions 7.0 or later.

Before you upgrade from version 6.x to 7.x, you must decide
which of the following actions to take:

■ To keep VSM, leave the server at the current 6.x version.

■ Before you upgrade to version 7.x, unmigrate all files
and remove VSM and any related products.

For instructions on how to remove VSM, refer to one of
the following sources:

NetBackup Storage Migrator Installation Guide.

VSM_README.txt file (located at the top of the Solaris
SPARC and HP PA-RISC media)

Veritas NetBackup Storage
Migrator (VSM)
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NetBackup 7.x server software is 64-bit compatible only and
cannot be installed on 32-bit systems.

If you have 32-bit systems with NetBackup 6.x master
servers that you want to upgrade, you must first migrate
the NetBackup catalog and databases to a supported 64-bit
system.

See “About replacing NetBackup server types not supported
in NetBackup 7.x” on page 37.

32-bit systems
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Starting with NetBackup 7.0, most of the add-on products
and database agents are now installed with the NetBackup
server or the client package. Separate installation for these
products is no longer needed.

The following products are now included in the NetBackup
server package (if the platform supports the product):

■ BMR master server

■ NDMP

■ Vault

The following products are now included in the NetBackup
client package (if the platform supports the product):

■ BMR Boot server

■ DB2

■ Encryption

■ Informix

■ LiveUpdate agent

■ Lotus Notes

■ Oracle

■ SAP

■ Snapshot Client

■ Sybase

The binaries for the listed products are laid down with the
server or the client package. A valid license is still required
to enable the product. If product configuration was required
previously (such as db2_config), configuration is still
required.

Note: For Solaris server upgrades, the older versions of any
listed products here must be removed before an upgrade to
NetBackup 7.x. For example, VRTSnbdb2, SYMCnbdb2,
VRTSnbenc,SYMCnbenc, and others. The installation script
displays a list of the packages it finds that must be removed.

The French, the Japanese, and the Chinese language
packages remain as separate add-ons. The process to install
and upgrade these products remains the same.

Warning: If you remove the earlier versions after an
upgrade to version 7.x, part of the NetBackup installation
is destroyed and the product cannot function.

UNIX package consolidation

Starting with NetBackup 7.5, you can decide the order in
which to upgrade the nodes. Either the active node or the
inactive nodes can be upgraded first.

Clusters
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The NetBackup Administration Console must be closed when
you upgrade NetBackup. Otherwise, NetBackup may cause
a failure that forces you to restart the procedure.

NetBackup Administration
Console

You should schedule your upgrade and reconfiguration for a time when backups
do not run. However, the upgrade procedure instructs you to deactivate all policies
to ensure that backups do not interfere with the upgrade. You can also temporarily
modify policies so that backups do not run while you upgrade and reconfigure
NetBackup.

To upgrade server software from versions 6.x or 7.x to 7.5

1 Run a hot catalog backup. If an error occurs during the upgrade, you can roll
back to the previous version and still retain your information from the catalog
backup.

This step is especially important for upgrades from 6.x versions because cold
catalog backup support was discontinued starting with NetBackup 7.0.

Catalog backups are typically scheduled to occur automatically from a catalog
backup policy. You can also initiate a hot catalog backup manually as follows:

Note: If a catalog backup policy does not exist, you must first create and
configure one to run a hot catalog backup. For complete details, see the
NetBackup Administartor's Guide, Volume I.

■ In the NetBackup Administration Console, expand NetBackup
Management > Policies.

■ Select the catalog backup policy you want to run.

■ Select Actions > Manual Backup.

You can also run the bpbackup command from the command line to perform
a full hot catalog backup. For complete details about this command, see the
NetBackup Commands Reference Guide.

2 Log on as the root user on the server.

3 Deactivate all NetBackup policies as follows:
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■ Open the NetBackup Administration Console on the
master server.

■ From the tree on the left, select Policies.

■ In the right pane, select all of the NetBackup policies
that appear.

■ Right-click on the selected policies, then select
Deactivate.

For NetBackup
Administration Console
users:

For command-line users, enter the following commands:

■ Navigate to the following directory:
cd /usr/openv/netbackup/bin/admincmd

■ To deactivate NetBackup policies, enter the following command:
./bpplinfo policy_name -modify -inactive

4 Deactivate disk staging storage units as follows:

■ On the master server, open the NetBackup
Administration Console.

■ From the tree on the left, expand NetBackup
Management > Storage Units.

■ In the right pane, double-click on a disk staging storage
unit.

■ When the Change Storage Unit dialog box appears,
select Staging Schedule.

■ When the Disk Staging Schedule dialog box appears,
click the Exclude Dates tab.

■ Select the date in the calendar that matches the date
of the system upgrade, then click OK. The storage unit
is then disabled on that date.

■ Click OK to close the DiskStagingSchedule dialog box,
then click OK to close the Change Storage Unit dialog
box.

■ Repeat these tasks for each disk staging storage unit.

For NetBackup
Administration Console
users:

For command-line users, navigate to the following directory:

cd /usr/openv/netbackup/bin/admincmd

Enter the following command:

./bpschedulerep schedulename -excl mm/dd/yyyy

5 Deactivate all media servers as follows:
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■ Open the NetBackup Administration Console on the
master server.

■ From the tree on the left, select Media and Device
Management > Devices > Media Servers.

■ In the right pane, select all of the media servers that
appear.

■ Right-click the media servers and select Deactivate.

For NetBackup
Administration Console
users:

For command-line users:

/usr/openv/volmgr/bin/vmoprcmd -deactivate_host -h device_host

6 If the NetBackup Administration Console is open, you must close it now.

7 For clustered environments, perform the following tasks:

■ If necessary, edit the bp.conf and the vm.conf files as follows:

If a REQUIRED_INTERFACE entry exists, replace it with a CLUSTER_NAME

entry. Otherwise, add a new CLUSTER_NAME entry. This entry should be
defined as the virtual server name.
For a master server, make sure that the first SERVER entry matches the
CLUSTER_NAME entry for the bp.conf file.

■ Freeze the NetBackup Group so that migrations do not occur while the
inactive nodes are upgraded.

■ If you have a VCS cluster configured, you can freeze the NetBackup Group
by using the Cluster Manager interface or the command line.

■ Before you proceed with a cluster upgrade, refer to theNetBackupClustered
Master Server Administrator's Guide for other cluster upgrade
requirements.
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8 For Solaris servers only, remove the 6.x or 7.x versions of all add-on products
and database agents.

Note: The installation script displays a list of the add-on products and the
agents that are currently installed. The script also offers to remove these
earlier versions for you and Symantec recommends this method.

Warning: You also have the option to remove these items manually before
the upgrade occurs. These items must be removed before you upgrade to
version 7.x. If you remove these items after an upgrade to version 7.x, part
of the NetBackup installation is destroyed and the product cannot function.
If you decide to remove these products manually, you must stop the upgrade
here. Refer to the appropriate NetBackup 6.x or 7.x documentation for
instructions on how to remove each add-on product or agent.

9 For Solaris systems, all of the NetBackup scripts that you may have modified
are removed when you complete this step.

Perform each of the following tasks in the order as shown:

■ Save any files that you have modified and want to keep.

■ Remove the current NetBackup server package by using the appropriate
command:

pkgrm VRTSnetbpFor version 6.0:

pkgrm SYMCnetbpFor versions 6.5 and later:

The following prompt appears:

Are you doing this pkgrm as a step in an upgrade

process?

■ Enter y.

10 For AIX systems, this step deletes any robotic control paths. In an AIX
clustered environment, you must perform this step on all nodes in the cluster.

For more information about the robotic control paths, see the NetBackup
Device Configuration Guide.

■ Remove the ovpass driver, as follows:

/usr/openv/volmgr/bin/driver/remove_ovpass
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11 Ensure that you have license keys for all of the NetBackup servers, clients,
options, and agents that you ordered.

When you install a NetBackup Enterprise master or a media server, you must
enter a NetBackup Enterprise server license key.

For more information on how to administer NetBackup licenses, see the
NetBackup Administrator’s Guide, Volume I.

12 Use one of the following methods to start the upgrade script:

■ Insert the NetBackup Server DVD for the
appropriate platform in the drive.

Check the DVD label to identify its contents.

See “About the NetBackup media kit” on page 28.

■ If necessary, mount the DVD.

See “About mounting the NetBackup software
media” on page 53.

■ Enter the following command:

cd_directory/install

The cd_directory is the path to the directory where
you can access the DVD.

DVD

■ Navigate to the location where the installation
images reside.

■ Enter the following command:

./install

ESD images (downloaded
files)

13 Follow the prompts in the installation script to install the NetBackup server
binaries.

During the active node upgrade, the following question appears:

Do you want to start the NetBackup job-related daemons so

backups and restores can be initiated? [y,n] (y)

Enter n and press Enter.

Do not start the NetBackup job-related processes until all nodes are upgraded.

14 For clustered environments only, unfreeze the NetBackup group.

15 After you have finished the upgrade, you can configure NetBackup Access
Control (NBAC).

For detailed information, see the NetBackup Security and Encryption Guide.
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16 After all servers are upgraded, reactivate the following in the order as shown:

■ All media servers

■ All disk staging storage units

■ All NetBackup policies, except for catalog backup policies.

Warning: Do not reactivate any catalog backup policies until after the
image metadata migration has completed. Also, do not attempt any catalog
recovery operations until after the image metadata migration has
completed. Once the image metadata migration is finished, remember to
reactivate catalog backup policies.

17 For upgrades to NetBackup 7.5, the image metadata migration must be
completed to finish the upgrade. Refer to the following information for
complete details:

■ See “About image metadata migration after upgrades to NetBackup 7.5”
on page 15.

■ Click on the following link to go to the NetBackup 7.5 Upgrade Portal and
review the NetBackup 7.5 Upgrade Guide:
http://www.symantec.com/docs/TECH74584
This guide describes the estimated migration times based on the migration
method and the number of images to be migrated.

■ See “Planning for image metadata migration after an upgrade to NetBackup
7.5” on page 19.

After all server software is upgraded, you are ready to install or upgrade client
software.

See “About NetBackup client installation” on page 115.

Upgrading clients after servers are upgraded
The update_clients installation script lets you push client software to clients.
It does not let you push client software to a remote client that is also a NetBackup
media or master server. You cannot push software this way because the server
software and client binaries must be of the same version on a single host.

The update_clients installation script can determine the full client list that is
configured on the server. When it is run without any parameters, it attempts to
update all clients (as determined by
/usr/openv/netbackup/bin/admincmd/bpplclients). If you do not want to
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upgrade all clients, you can specify a subset of clients. Use the hardware type and
operating system parameters or use the -ClientList parameter.

You can run update_clients from a media server. The -ClientList parameter
is required in this situation. The script lets you maintain a media server and a set
of clients at an earlier release level than the master server. Doing so requires the
informed use of the update_clients -ClientList command on a master server
and a media server to avoid unwanted client upgrades.

For clustered environments, you can push client software only from the active
node.

During a client upgrade, the new client files are written to a directory in /tmp on
the client. This directory must have sufficient space to temporarily store the new
client files to ensure a successful upgrade. If sufficient space is not available, a
status message informs you that the upgrade script could not write to the location
in the /tmp directory. To resolve this issue, allocate more space to the /tmp

directory and perform the upgrade procedure again. The temporary directory is
removed when the upgrade is complete.

To upgrade clients after you have upgraded servers

1 Use one of the following methods to start the installation script:

■ Insert the NetBackup UNIX Clients DVD into the
drive.

See “About the NetBackup media kit” on page 28.

■ If necessary, mount the DVD.

See “About mounting the NetBackup software
media” on page 53.

■ Enter the following command:

cd_directory/install

The cd_directory is the path to the directory where
you can access the DVD.

DVD
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■ Navigate to the location where the installation
images reside.

■ Enter the following command:

./install

ESD images (downloaded
files)

2 When the following message appears, press Enter to continue:

Installing NetBackup Client Software.

Do you wish to continue? (y/n) [y]

The client binaries represent the operating system versions where the binaries
were compiled. The binaries typically function perfectly on later versions of
the operating system. For example, HP PA-RISC 11.11 binaries also are used
on the HP PA-RISC 11.23 level of the operating system.

3 Select the client type that you want to load and follow the prompts to load
that client type. Repeat as necessary until all desired client types have been
loaded.

Make sure that you load the software for all of the UNIX client types that you
intend to push to from this server. Otherwise, you cannot add these client
types to the NetBackup policy configuration.

4 After the installation is complete, unmount the DVD.

5 As a root user on the NetBackup master server, enter the following command
to see whether bprd is running:

/usr/openv/netbackup/bin/bpps

If bprd is running, stop it with the following command:

/usr/openv/netbackup/bin/admincmd/bprdreq -terminate

6 Enter the following command to make sure that backups or restores are not
in progress:

/usr/openv/netbackup/bin/admincmd/bpdbjobs

7 Update UNIX client software by running the update_clients script. Specify
the host names of the individual nodes (not virtual names) in the list of clients.

Use one of the following commands:

/usr/openv/netbackup/bin/update_clientsIf you do not use a
-ClientList file:
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/usr/openv/netbackup/bin/update_clients

-ClientList filename

If you use a
-ClientList file:

The -ClientList parameter is required on a media server.

For more than 30 clients, you can divide the list into multiple files and run
update_clients for each file.

To create a client list file, perform the following steps:

■ Change to the NetBackup admincmd directory, as follows:

cd /usr/openv/netbackup/bin/admincmd

■ Use the bpplclients command to create a file that contains a list of clients
currently configured in the NetBackup database. The options to use on
this command differ depending on whether you push from a master server
or from a media server, as follows:

./bpplclients -allunique -noheader > fileIf you push from the
master server:

./bpplclients -allunique -noheader -M \

m_server_name > file

If you push from a media
server:

The option descriptions are as follows:

Name of the NetBackup master server in this environment.m_server_name

Name of the file to contain the list of unique clients. If no
clients have been configured in the NetBackup database, the
file is empty.

file

The bpplclients command writes output to file in the following format:

hardware os client

The hardware name. For example, run the ls command in
directory /usr/openv/netbackup/client.

hardware

The operating system name. For example, run the ls
command in directory
/usr/openv/netbackup/client/hardware.

os

The name of the client.client
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The contents of file might look like the following example:

Solaris Solaris9 curry

■ (Optional) Edit file.

Perform this step to change the contents of file. Edit file to contain
only those clients you want to update with NetBackup client software.
The host names of the clients must be the clients’ individual node names.
They cannot be virtual names. Thehostname command and thedomainname
command return the correct values for the individual node names. The
format can be either hostname or hostname.domainname.

8 The update_clients script requests information from you. The following
information appears in the script:

Starting update_clients script.

There are N clients to upgrade.

Do you want the bp.conf file on the clients updated to list this

server as the master server? (y/n) [y]

Type either y or n.

Enter the number of simultaneous updates you wish to take

place. [1 - 30] (default: 15):

Press Enter.

The upgrade will likely take Y to Z minutes.

Do you want to upgrade clients now? (y/n) [y]

Type either y or n.

9 After all servers and clients are updated, start the bprd daemon as the root
user on the master server by entering the following command:

/usr/openv/netbackup/bin/initbprd

10 After you have upgraded the NetBackup software, proceed to following topic:

See “Completing your system update after an upgrade” on page 101.

Completing your system update after an upgrade
After you have upgraded servers and clients, you may need to perform additional
tasks to complete the update of your NetBackup environment.

Perform any of the following that apply to your NetBackup environment:
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If you upgraded a master server that allowed nonroot users
to administer NetBackup, you must reconfigure the
permissions and the group. The default permissions and
group on the newly installed files allow only a root user to
perform NetBackup administration.

Master server privileges

Upgrade any add-on products (such as NetBackup language
packages) on all upgraded clients. All add-on products
should be at the same version as the NetBackup client.

Add-on products

If you made changes to NetBackup scripts before the
upgrade, apply those changes to the new, upgraded versions
of the scripts.

NetBackup scripts

Automatic file changes from an upgrade
When you upgrade from an earlier NetBackup version, certain customizable scripts
are overwritten. Before NetBackup overwrites these scripts, it saves copies of
them as a record of your modifications.

The following examples describe how this process works:

Your current NetBackup version is 6.5 and you modified
files in the goodies directory. For example:

/usr/openv/netbackup/goodies

After an upgrade to NetBackup 7.5, the following directory
is created automatically and contains the modified files
from the earlier version:

/usr/openv/netbackup/goodies.6.5

If you made changes to these scripts before the upgrade,
apply those changes to the new 7.5 scripts.

Example 1: goodies directory

Your current NetBackup version is 6.5 and you modified
files in the bin directory. For example:

/usr/openv/netbackup/bin/backup_notify

After an upgrade to NetBackup 7.5, any modified scripts in
the bin directory now include the earlier version in their
file name. For example:

backup_notify.6.5

If you made changes to these scripts before the upgrade,
apply those changes to the new 7.5 scripts.

Example 2: bin directory
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Table 5-1 describes the files and scripts that are overwritten when you upgrade
from an earlier UNIX version of NetBackup:

Table 5-1 Overwritten files and scripts on UNIX systems

Affected files and scriptsPath

All files/usr/openv/netbackup/bin/goodies

All files/usr/openv/netbackup/help

Some files and directories/usr/openv/volmgr

backup_notify

backup_exit_notify

bpend_notify (present only if used)

bpend_notify_busy (present only if used)

bpstart_notify (present only if used)

dbbackup_notify

diskfull_notify

initbpdbm

initbprd

restore_notify

session_notify

session_start_notify

userreq_notify

/usr/openv/netbackup/bin

drive_mount_notify (present only if used)

drive_unmount_notify (present only if used)

/usr/openv/volmgr/bin/goodies

shared_drive_notify/usr/openv/volmgr/bin
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Removing NetBackup server
software

This chapter includes the following topics:

■ About NetBackup server software removal on UNIX systems

About NetBackup server software removal on UNIX
systems

NetBackup removal procedures remove NetBackup completely, along with any
installed add-on products. Each procedure gives you the opportunity to save any
data that you want and to remove add-on products before you remove NetBackup.

Symantec recommends that you use the following order when you remove
NetBackup server software:

■ Save any data that you require.
This task is very important if you plan to reinstall NetBackup at a later date.

■ Remove any add-on products before you remove NetBackup server software.

■ Remove the NetBackup server software.

See “Removing NetBackup from UNIX servers” on page 106.

See “About NetBackup software removal on UNIX clients” on page 143.

See “Removing NetBackup from UNIX clients” on page 143.
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Removing NetBackup from UNIX servers
Use this procedure to remove NetBackup from a UNIX server. You may also need
to reference other documents for procedures of specific tasks to remove NetBackup
successfully.

Use the following guidelines when you remove NetBackup from UNIX servers:

If you moved the NBDB files in/usr/openv/db/data from
their default installation location, this procedure includes
a step that describes how to remove these files.

NetBackup relational
database (NBDB) location

Before you begin to remove NetBackup, you must remove
NetBackup from the cluster application. Follow the
instructions in your cluster documentation on how to
remove a group, then you can remove NetBackup.

You must remove NetBackup from each node in the cluster.

Clustered environments

If you identified an alternate root path in your NetBackup
7.5 installation or upgrade, the process prompts you with
the alternate root path. You can use thepkgrm -R command
from the alternate root location.

This command applies only to NetBackup Solaris servers,
not add-ons, or clients.

Alternate root path (Solaris
systems only)

If NetBackup has been configured to run as a clustered
package, you must also delete the following directory:

/etc/cmcluster/netbackup

HP-UX Service Guard
Clusters

When you remove NetBackup, PBX is not removed. You must
remove PBX manually. This procedure includes a step that
describes how to perform this task.

Warning: Do not remove PBX if your server uses other
Symantec software products that require PBX to run.

PBX

The NetBackup Administration Console must be closed when
you remove NetBackup. Otherwise, NetBackup may cause
a failure that forces you to restart the procedure.

NetBackup Administration
Console

To remove NetBackup from UNIX servers

1 Log on as the root user on the server.

2 Perform a catalog backup.

3 If the NetBackup Administration Console is open, you must close it now.

4 Save all important data from any add-on products that you have installed.
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5 Stop the NetBackup/Media Manager daemons with the following command:

/usr/openv/netbackup/bin/bp.kill_all

6 Identify any installed add-on products by using the following command:

lslpp -LAIX

swlistHP-UX

rpm -qaLinux

pkginfoSolaris

Remove each identified add-on product.

7 For Solaris systems only, run the following command:

/usr/openv/volmgr/bin/driver/sg.install -deinstall

<pkg-install-root>

8 To unregister NetBackup from the VxUL master configuration that is stored
in the /etc/vx/vrtslog.conf file, run the following command:

/usr/openv/netbackup/bin/vxlogcfg -r -p 51216

The -p option specifies the product ID, which is 51216 for NetBackup.

9 If BMR is supported and enabled on the server, remove the associated files
with the following command:

/usr/openv/netbackup/bin/bmrsetupmaster -undo -f

10 To unregister all NetBackup products with LiveUpdate, enter the following
command:

/usr/openv/netbackup/bin/nblu_registration -r

11 If you moved the NBDB files from their default installation location, you must
delete these files manually as follows:

■ Navigate to the following directory where the NBDB files reside:
/usr/openv/db/data

■ Open the vxdbms.conf file.

This file contains a list of the database-related files and the path for each
file.

■ Delete each of the database-related files.
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12 If NetBackup Fibre Transport is supported and enabled on the server, remove
the associated files with the following command:

/usr/openv/netbackup/bin/admincmd/nbftsrv_config -d

13 For the clients that support PureDisk, remove all PureDisk files with the
following command:

/opt/pdde/pddeuninstall.sh -basedir /usr/openv/pdde/ -ostdir

/usr/openv/lib/ost-plugins/ -forceclean

14 To remove the NetBackup server package, run the following command:

installp -u SYMCnetbpAIX

swremove SYMCnetbpHP-UX

rpm -e SYMCnetbpLinux

pkgrm SYMCnetbp

■ When the script asks if you want to remove the
installed package SYMCnetbp, enter y and press
Enter.

■ When the script asks if you want to continue with
the package removal using superuser permission,
enter y and press Enter.

Solaris

15 Remove the NetBackup-Java Display Console by using the appropriate native
command as follows:

installp -u SYMCnbjavaAIX

swremove SYMCnbjavaHP-UX

rpm -e SYMCnbjavaLinux

pkgrm SYMCnbjavaSolaris
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16 Remove the NetBackup Java Runtime Environment by using the appropriate
native command as follows:

installp -u SYMCnbjreAIX

swremove SYMCnbjreHP-UX

rpm -e SYMCnbjreLinux

pkgrm SYMCnbjreSolaris

17 Remove the NetBackup client by using the appropriate native command as
follows:

installp -u SYMCnbcltAIX

swremove SYMCnbcltHP-UX

rpm -e SYMCnbcltLinux

pkgrm SYMCnbcltSolaris

18 Remove PBX with the appropriate native command as follows:

Note: Remember, you should not remove PBX if your server uses other
Symantec software products that require PBX to run.

installp -u VRTSpbxAIX

swremove VRTSpbxHP-UX

rpm -e VRTSpbxLinux

pkgrm VRTSpbxSolaris

19 To remove the /usr/openv directory, select one of the following methods:

Warning:The rm -f /usr/openv command also removes any add-on products
that are installed on the computer where you perform this command.

■ If /usr/openv is the actual directory, run the following command:
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rm -rf /usr/openv

■ If /usr/openv is a symbolic link to that directory, run the following
commands:

cd /usr/openv

pwd

ls

Warning: Before you continue, make sure that you are at the correct
location and verify that the subdirectories are what you expect them to
be. To help prevent removing the wrong directories, the previous
commands verify your current location and list the files in that directory.
After you verify the directory location and its contents, remove the
directory with the next commands.

rm -rf *

cd /

rm -f /usr/openv

20 For Linux systems only:

If you modified the startup and the shutdown scripts, run the following
command:

/sbin/chkconfig --del netbackup

See “About NetBackup startup and shutdown scripts” on page 151.
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21 Remove the following startup scripts:

/etc/rc.netbackup.aix
On AIX systems:

/sbin/init.d/netbackup
On HP-UX systems:

/sbin/rc1.d/K001netbackup
/sbin/rc2.d/S777netbackup

/etc.init.d/netbackup
/etc/rc0.d/K01netbackup

On Linux Debian
systems:

/etc/rc1.d/K01netbackup
/etc/rc2.d/S95netbackup

/etc/rc.d/init.d/netbackup
On Linux Red Hat
systems:

/etc/rc.d/rc0.d/K01netbackup
/etc/rc.d/rc1.d/K01netbackup
/etc/rc.d/rc2.d/S77netbackup
/etc/rc.d/rc3.d/S77netbackup
/etc/rc.d/rc5.d/S77netbackup
/etc/rc.d/rc6.d/K01netbackup

The following startup scripts appear only if NetBackup
Fiber Transport was enabled on the server:

/etc/rc.d/init.d/nbftserver
/etc/rc.d/rc0.d/K03nbftserver
/etc/rc.d/rc1.d/K03nbftserver
/etc/rc.d/rc2.d/S21nbftserver
/etc/rc.d/rc3.d/S21nbftserver
/etc/rc.d/rc5.d/S21nbftserver
/etc/rc.d/rc6.d/K03nbftserver
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/etc/init.d/netbackup
/etc/init.d/rc0.d/K01netbackup
/etc/init.d/rc2.d/S77netbackup
/etc/init.d/rc3.d/S77netbackup
/etc/init.d/rc5.d/S77netbackup
/etc/init.d/rc6.d/K01netbackup

The following startup scripts appear only if NetBackup
Fiber Transport was enabled on the server:

/etc/init.d/nbftserver
/etc/init.d/rc2.d/K01nbftserver
/etc/init.d/rc2.d/S05nbftserver
/etc/init.d/rc3.d/K01nbftserver
/etc/init.d/rc3.d/S05nbftserver
/etc/init.d/rc5.d/K01nbftserver
/etc/init.d/rc5.d/S05nbftserver

On Linux SUSE systems:

/etc/init.d/netbackup
/etc/rc0.d/K01netbackup
/etc/rc1.d/K01netbackup
/etc/rc2.d/S77netbackup

The following startup scripts appear only if NetBackup
Fiber Transport was enabled on the server:

/etc/init.d/nbftserver
/etc/rc0.d/K03nbftserver
/etc/rc1.d/K03nbftserver
/etc/rc2.d/S21nbftserver

On other servers:

22 For AIX systems only:

■ In the /etc/inittab file, remove the following NetBackup entry:

/etc/rc.netbackup.aix

■ In the /etc/rc.shutdown file, remove the following line:

/etc/rc.netbackup.aix stop

23 Remove Symantec LiveUpdate components as follows:
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■ If NetBackup is the only Symantec product that currently uses LiveUpdate,
run the following command:
/opt/Symantec/LiveUpdate/uninstall.sh -a

■ If LiveUpdate is the only product installed in the /opt/Symantecdirectory,
remove the following files:
rm -f /etc/Symantec.conf

rm -f /etc/Product.Catalog.JavaLiveUpdate

24 To remove the NetBackup-Java application state data for the root account,
run the appropriate command as follows:

Warning: Do not insert a space between the slash character (/) and the period
or dot character (.) of /.veritas. A space between these characters removes
all of your files from the root level and beyond.

■ To remove the NetBackup-Java application state data for the root account
for all releases, run the following command:
/bin/rm -rf /.veritas

■ To remove the NetBackup-Java application state data for the root account
for a specific release, run the following command:
/bin/rm -rf /.veritas/java/<version>

Where<version> is the six-digit NetBackup version number. For example,
NetBackup version 7.5 with no upgrades applied would be entered as
750000.

25 Inform NetBackup-Java users that they can remove their $HOME/.veritas
directory.

The $HOME/.veritas and the $HOME/.veritas/java directories contain
application state information, that is saved when the user exits
NetBackup-Java applications. The saved information includes table column
order and size. The process removes this directory for the root user only.

The common subdirectory in $HOME/.veritas/java/.userPrefs/vrts can
be removed.

26 If you enabled NetBackup Access Control, NetBackup placed several files on
clients and servers. These files can be divided into the following categories:

These files are removed with NetBackup.NetBackup application
temporary files
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These cache files reside in the$HOME/.vxssdirectory.
Inform all users that they can remove this directory.

Files are generated in the/.vxss directory by a Single
Sign-On operation of the NetBackup Administration
Console on the host where the console runs. The
NetBackup Administration Console cleans these files
when an exit function is performed, so the directory
does not always contain temporary files. However, if
a system crash were to occur, any files in the directory
may be left behind. With the console shutdown , you
can delete these files safely with no data loss.

NetBackup also creates cached certificates for client
and server NetBackup applications. These files reside
within the/.vxssdirectory. These files typically have
a name that is consistent with a DNS entry for a
network interface, as in machine.company.com.
Example directory entries are as follows:

/usr/openv/var/vxss/credentials/machine.company.com

/usr/openv/var/vxss/credentials/dhcp

These files are created with the command bpnbat

-LoginMachine. If you plan to reinstall NetBackup on
the same computer at a later date, do one of the
following:

■ Preserve the certificates in the
vxss/credentials directory.

■ If you do not preserve the certificates, you must
provide the computer identity password as
originally set on the Root+AB broker. As an
alternative, you can reset the password on the
Root+AB broker when you reinstall.

For more information on Root+AB brokers, see the
NetBackup Security and Encryption Guide.

For more information on NetBackup Access Control
and how to remove it, see the NetBackup Security and
Encryption Guide.

Individual user (cache) files
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Installing NetBackup client
software

This chapter includes the following topics:

■ About NetBackup client installation

■ About NetBackup client installation on Windows

■ About NetBackup client installation on UNIX

About NetBackup client installation
By definition, NetBackup servers are also clients. When you install NetBackup
server software, client software is also installed.

When you install client software, you perform a true client installation since no
server software is installed.

Client software can be installed locally at each individual computer or remotely.
The operating system determines which clients can be installed remotely.

A Windows host can only push client software to Windows
clients.

NetBackup does not need to be installed on the host that is
used to perform the remote client installation.

Windows

A NetBackup UNIX server can only push client software to
UNIX clients.

NetBackup software and client type software must be
installed on the server that is used to perform the remote
client installation.

UNIX
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About NetBackup client installation on Windows
The NetBackup client installation wizard for Microsoft Windows lets you select
the appropriate setup and installation options from a series of wizard screens.
After you select options, a window appears that lets you verify your selections
before the installation begins.

While the installation is in progress, a dialog box provides details of the installation
and the setup progress. When the installation is completed, a final window shows
the results.

Note the following when you install NetBackup client software on Windows
systems:

You cannot install NetBackup client software on the
computers that currently have NetBackup server software.
In these cases, you must first remove the NetBackup server
software.

See the NetBackup Installation Guide for Windows..

Client installation
restrictions

■ By default on Windows 2003, 2008, and 2008 R2 Server
systems, only administrators have write permission to
the Program Files directory.

■ NetBackup writes log files and progress files to the
following location:

Program Files\VERITAS\NetBackup\Logs

To perform backups and restores with the Backup,
Archive, and Restore interface, users must have write
permission to the Logs directory. Users without write
permission to this directory receive an error message,
and the backup or restore is canceled. The administrator
account has write permission by default, but you must
ensure that other users also have write permission.

User permissions

About Windows client system requirements
The following describes the hardware and the software requirements for successful
installation of NetBackup client software.
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To install NetBackup client software locally, the system
must meet the following configuration requirements:

■ Microsoft Windows 2003/XP, Windows 2008/Vista, or
Windows 2008 R2/Windows 7

■ Any TCP/IP transport that is Windows Sockets
compliant. (Use of the TCP/IP transport that comes with
the server or the operating system is recommended.)

■ A network adapter that your TCP/IP transport supports

Local installation

To install NetBackup client software remotely, the system
must meet the following configuration requirements:

■ All the requirements for local installations must be met.

■ The source system must run Windows 2003, 2008, or
2008 R2 Server.

■ Administrator privileges are required for the user that
performs remote installations.

Remote installation

The NetBackup client version that you install must be the
same or earlier than the installed version of NetBackup
server software. Later client versions cannot be used with
earlier server versions.

See “About NetBackup mixed version support” on page 26.

NetBackup version
compatibility

About Windows client installation methods
You can install NetBackup clients on Windows systems with the following methods:

The installation wizard installs the client software only on
the computer where you run the installation.

See “Installing NetBackup Windows clients locally”
on page 118.

Local installation

The installation wizard scans the network for available
clients where you can install the client software.

The source computer must run Windows 2003, 2008, or
2008 R2 Server.

Also, a remote installation requires system administrator
privileges.

Note: You cannot install clients remotely from NetBackup
Windows servers to UNIX computers.

See “Installing NetBackup Windows clients remotely”
on page 121.

Remote installation
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A silent installation is a process that does not require
interactive input. However, you must edit the
silentclient.cmd file before you run it.

See “Installing NetBackup Windows clients silently”
on page 127.

Silent installation

See “About NetBackup client installation” on page 115.

Installing NetBackup Windows clients locally
Follow these instructions to install the NetBackup client software on your local
Windows system. You can stop the installation process at any time by clicking
Cancel or by clicking Back to return to the previous window.

Note:After client installation, you may need to restart the system for the changes
to take effect.

To install NetBackup client software locally on Windows systems

1 Log on as administrator on the host where you want to install the client
software.

2 Start the NetBackup Installation Wizard with one of the following methods:

■ DVD media
Insert the NetBackup for Windows DVD in the drive. If Autorun is disabled,
navigate to the DVD drive and run Browser.exe.

■ ESD images (downloaded files)
Navigate to the directory where the images reside and run Browser.exe.

3 On the initial screen, select Installation.

4 On the Installation screen, select Client Software Installation.

5 On the Welcome screen, review the content and click Next.

6 On the License Agreement screen, accept the terms of the agreement and
click Next.

Installing NetBackup client software
About NetBackup client installation on Windows

118



7 On the Symantec NetBackup Client Installation Type screen, provide the
following information:

For a local installation, select Install to thiscomputer
only.

Where to install

Select this option to install NetBackup default features
and settings.

Typical

Select this option to choose the NetBackup features to
install and the settings that you want.

Custom

Click Next.

8 This step applies only to Custom installations. For Typical installations, skip
to step 10.

On the Symantec NetBackup Client Features screen, you can select the
features to install and where the NetBackup files are installed.

Click the icon next to any feature and a drop-down
menu appears.

Select Install or Do not install.

Feature List

By default, NetBackup files are installed to the
following location:

C:\Program Files\VERITAS

To change the folder destination where NetBackup is
installed:

■ Click Change.

■ Browse to the preferred location and designate a
new or an existing folder.

■ Click Next.

Note: For upgrades, you cannot change the destination.

Destination Folder

9 This step applies only to Custom installations. For Typical installations, skip
to the next step.

On the NetBackup Options screen, select from the following options:

119Installing NetBackup client software
About NetBackup client installation on Windows



Enable or disable the following options:

■ Start NetBackup Client Service Automatically
By default, this option is enabled so that NetBackup
services are available immediately after system
startup.

■ StartNetBackupClientJobTrackerAutomatically
By default, this option is disabled. To start this
option manually after installation, click Start>All
Programs > Symantec NetBackup > NetBackup
Client Job Tracker.

At System Startup

On this screen, you can change port numbers, if it is
necessary in your configuration.

You may need to change a port number if you
encounter conflicts when NetBackup and another
industry product try to share the same port. Another
example is if a port conflict occurs with a firewall,
which may cause security issues.

To change a port number, select the port number that
you want to replace and type the new number.

Ports

Click Next.

10 On the NetBackup Services screen, provide the following startup account
and startup type information for NetBackup client services:

By default, this box is checked so that NetBackup uses
the built-in system account. When this box is checked,
the fields below it are disabled.

To specify a different system account:

■ Click this box to remove the check mark.

■ Enter the account information in the following
fields:

Username
Password
Domain

Use the built-in system
account
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This option determines how the installation proceeds
if a restart is required as part of the installation or
upgrade.

If you select this option and the installation process
determines that a restart is required, the installation
(or upgrade) stops. The system is then rolled back to
its original state.

If you do not select this option, the installation (or
upgrade) proceeds even if the installation process
determines that a restart is required.

Abort install if a reboot is
required

11 On the NetBackupSystemNames screen, the following fields are populated
automatically. Normally, changes are not required. Except for the Client
Name, you can make changes as needed for your configuration.

Do not change this name.Client Name

If necessary, change this name to the appropriate
master server where the client backup images are to
be stored.

Master Server Name

Enter all of the master server and media server names
that you want this client to access.

Additional Servers

12 On the ReadytoInstalltheProgram screen, review the InstallationSummary
that shows your selections from the previous steps. Then select one of the
following options:

■ Click Install to start the installation.

■ Click Back to view the previous screens and make any changes, then return
to this screen and click Install.

■ Click Cancel to cancel the installation.

After you click Install, the installation process begins and a screen appears
that shows you the installation progress. This process may take several
minutes.

13 On the Installation Complete screen, click Finish.

Installing NetBackup Windows clients remotely
Use this procedure to install NetBackup client software to multiple computers on
your network, including the local computer. You can stop the installation process
at any time by clicking Cancel.
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When you install Windows clients remotely, note the following:

Review the requirements for Windows client installation.

See “About Windows client system requirements”
on page 116.

Requirements

You must have administrator privileges on the remote
clients for the NetBackup installation to complete
successfully.

Privileges

During installation, the client name is written to the registry
in lowercase. For backups to work, the policies on the
NetBackup server must specify the client names in
lowercase.

Client name entries

You may need to restart the local or the remote systems for
the changes to take effect. A message appears to alert you
if a restart is needed.

Reboot after installation

To install NetBackup client software remotely on Windows systems

1 Log on as administrator on the host or the system server.

2 Start the NetBackup Installation Wizard with one of the following methods:

■ DVD media
Insert the NetBackup for Windows DVD in the drive. If Autorun is disabled,
navigate to the DVD drive and run Browser.exe.

■ ESD images (downloaded files)
Navigate to the directory where the images reside and run Browser.exe.

On the initial screen (Home), select Installation.

3 On the Installation screen, select Client Software Installation.

4 On the Welcome screen, review the content and click Next.

5 On the License Agreement screen, accept the terms of the agreement and
click Next.
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6 On the Symantec NetBackup Client Installation Type screen, provide the
following information:

For remote installation, select Install to multiple
computers on your network.

The procedure does not install the client on the local
host unless you add it to the list of systems that you
want to install.

Where to install

Select this option to install NetBackup default features
and settings.

Typical

Select this option to choose the NetBackup features to
install and the settings that you want.

Custom

7 This step applies only to Custom installations. For Typical installations, skip
to the next step.

On the NetBackup Options screen, select from the following options:

Enable or disable the following options:

■ Start NetBackup Client Service Automatically
By default, this option is enabled so that NetBackup
services are available immediately after system
startup.

■ StartNetBackupClientJobTrackerAutomatically
By default, this option is disabled. To start this
option manually after installation, click Start>All
Programs > Symantec NetBackup > NetBackup
Client Job Tracker.

At System Startup

On this screen, you can change port numbers, if it is
necessary in your configuration.

You may need to change a port number if you
encounter conflicts when NetBackup and another
industry product try to share the same port. Another
example is if a port conflict occurs with a firewall,
which may cause security issues.

To change a port number, select the port number that
you want to replace and type the new number.

Ports

8 On the NetBackup Services screen, provide the following startup account
and startup type information for NetBackup client services:
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By default, this box is checked so that NetBackup uses the built-in
system account. When this box is checked, the fields below it are
disabled.

To specify a different system account:

■ Click this box to remove the check mark.

■ Enter the account information in the following fields:

Username
Password
Domain

Use the built-in
system account

Check this box to prevent a reboot while you perform a remote
installation. When you check this box, processes that use the
NetBackup executables and DLLs are stopped.

Warning: For Oracle users, if you select this option, you must
take down your database before you continue the installation.

Terminate
NetBackup
processes

This option determines how the installation proceeds if a restart
is required as part of the installation or upgrade on the remote
system.

If you select this option and the installation process determines
that a restart is required, the installation (or upgrade) stops. The
system is then rolled back to its original state.

If you do not select this option, the installation (or upgrade)
proceeds even if the installation process determines that a restart
is required.

Abort install if a
reboot isrequired

9 On the NetBackupSystemNames screen, the following fields are populated
automatically. Change these fields to meet your specific needs.

If necessary, change this name to the appropriate
master server where the client backup images are to
be stored.

Master Server Name

Enter all of the master server and media server names
that you want the clients to access.

Additional Servers

10 On the Symantec NetBackup Remote Hosts and Features screen, specify
the hosts where you want NetBackup and any selected features installed.

■ Destination Systems
Right-click the Windows Destination Computers icon and select from
the drop-down menu , or use the following icons:
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Click here to search the network for the hosts
where you want to install NetBackup.

■ On the AvailableSystems dialog box, select the
computer to add and click Next.

■ On the Remote Computer Login Credentials
dialog box, enter the User Name and the
Password of the account to be used to perform
the installation on the remote computers.

■ If you plan to install to multiple remote
computers, click the box next to Remember
UserNameandPassword. Selecting this option
prevents the need to enter this information for
each remote computer.

■ Click OK.

■ On the Remote Destination Folder dialog box,
verify or change the DestinationFolder where
NetBackup is installed.

The default location is C:\Program
Files\Veritas.

If you plan to install to multiple remote
computers and you want to use the same
location, click the box next to Use this folder
for subsequent systems. Selecting this option
prevents the need to enter the location for each
remote computer.

Browse

Click here to import a text file that contains a list
of host names. When you create the text file, the
host names must be defined in the following
format:

Domain\ComputerName

Import
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Click here to add a host manually.

■ On the Manual Remote Computer Selection
dialog box appears, enter the Domain and the
Computer Name, then click OK.

■ On the Remote Computer Login Credentials
dialog box, enter the User Name and the
Password of the account to be used to perform
the installation on the remote computers.

If you plan to add and install to multiple remote
computers, click the box next to Remember
UserNameandPassword. Selecting this option
prevents the need to enter this information for
each remote computer.

■ Click OK.

■ On the Remote Destination Folder dialog box,
verify or change the DestinationFolder where
NetBackup is installed.

The default location is C:\Program
Files\Veritas.

If you plan to install to multiple remote
computers and you want to use the same
location, click the box next to Use this folder
for subsequent systems. Selecting this option
prevents the need to enter the location for each
remote computer.

■ Click OK.

Add

To remove a host from the Destination Systems
list, select the host and click here.

Remove

Click here to change the destination for NetBackup
file installation on the selected remote host.

Change

■ Features
Click a feature icon and select either Install or Do not install from the
drop-down menu .

■ Click Next.

11 On the ReadytoInstalltheProgram screen, review the InstallationSummary
that shows your selections from the previous steps. Then select one of the
following options:

■ Click Install to initiate the installation.

■ Click Back to view the previous screens and make any changes, then return
to this screen and click Install.
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■ Click Cancel to cancel the installation.

After you click Install, the installation process begins and a screen appears
that shows you the installation progress for each computer. This process may
take several minutes.

Up to five remote installations occur simultaneously. When a remote
installation is completed, another one begins so that a maximum of five
installations are in progress.

If you click Cancel after you click Install, the installation does not stop
immediately. Installation continues on all remote hosts where the installation
has already started. Any specified hosts after that point do not get client
software installed.

NetBackup considers any remote installations that were completed when you
clicked Cancel to be successful.

12 Examine the installation log on the following location:

%ALLUSERSPROFILE%\Symantec\NetBackup\InstallLogs\

An installation log file provides detailed installation information and shows
whether any errors occurred.

Note: When you perform a remote installation to multiple computers, this
option only lets you view the log for the local computer. Each computer that
you selected for installation contains its own installation log file. To view the
log file of a remote computer, open a Windows Explorer window and enter
\\<COMPUTERNAME>.

Search the installation log for the following error indications:

■ Strings that include Return Value 3.

■ Starting with NetBackup 7.0, important log messages are color coded as
follows:
Yellow = warning.
Red = error.

Installing NetBackup Windows clients silently
A silent installation process does not require interactive input. It does, however,
require that you edit the silentclient.cmd file before you run it.

Silent installations of NetBackup clients are not supported if you want to run the
NetBackup services as a user instead of a local administrator.
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To install NetBackup with a custom services account, refer to the following topics:

See “Installing NetBackup Windows clients locally” on page 118.

See “Installing NetBackup Windows clients remotely” on page 121.

Use the following procedure to perform a silent installation of a local NetBackup
client.

To perform a silent installation of NetBackup client software on Windows

1 Insert the NetBackup installation DVD in the drive or navigate to the location
where the ESD images (downloaded files) reside.

2 In a Microsoft Windows Explorer window, navigate to the DVD drive.

3 Copy the contents of the one of the following directories to a temporary folder
on your hard drive. For example, C:\temp.

■ PC_Clnt\x86

■ PC_Clnt\x64

4 Since the original source files are read-only, change the permissions for the
copied files on the hard drive to allow the update.

5 In the temporary directory, use a text editor to edit the silentclient.cmd

file so the script installs the client software as needed.

6 Run the silentclient.cmd script.

7 To verify that the installation was successful, check the installation log file
in the following directory:

%ALLUSERSPROFILE%\Symantec\NetBackup\InstallLogs

How to configure NetBackup clients
You can configure NetBackup clients by performing one of the following actions:

■ Start the Backup, Archive, and Restore interface.

■ Click File > Specify NetBackup Machines.

To add servers or media
servers:

■ Start the Backup, Archive, and Restore interface.

■ Click File > NetBackup Client Properties.

To display and change the
client properties:
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■ Open the NetBackup Administration Console.

■ Expand Host Properties and click Clients.

■ In the right pane, right-click on the client and choose
Properties.

In the dialog box that appears, on the Servers tab, all
NetBackup servers that require access to your Windows
client must be listed.

To display and change the
server properties:

For complete information on client configuration, see the NetBackup
Administrator's Guide, Volume I.

About NetBackup client installation on UNIX
You can install UNIX clients either locally at the client computer or remotely from
your UNIX NetBackup server. To install client software remotely from a UNIX
NetBackup server, the client type software must first be installed on the UNIX
server.

Note:Macintosh OS X clients are UNIX-based clients. Follow the same UNIX client
installation procedures in this section.

Note the following when you install NetBackup client software on UNIX systems:
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Starting with NetBackup 7.0, many of the add-on products
and database agents are now installed with the NetBackup
client package. Separate installation for these products is
no longer needed.

The following products are now included in the NetBackup
7.5 client package (if the platform supports the product):

■ BMR Boot server

■ DB2

■ Encryption

■ Informix

■ LiveUpdate agent

■ Lotus Notes

■ Oracle

■ SAP

■ Snapshot Client

■ Sybase

The binaries for the listed products are laid down with the
client package. A valid license is still required to enable the
product. If product configuration was required previously
(such as db2_config), configuration is still required.

The French, Japanese, and Chinese language packages
remain as separate add-ons. The process to install and
upgrade these products remains the same.

UNIX package consolidation

The gzip and the gunzip commands must be installed on
each system. The directories where the commands are
installed must be part of the root user’s PATH environment
variable setting.

gzipandgunzipcommands

To initiate a backup or a restore from a UNIX client, the
following graphical interfaces are available:

■ Clients that are compatible with NetBackup-Java may
use the NetBackup-Java interface (jbpSA).

Refer to the NetBackup Release Notes for a list of
NetBackup-Java capable hosts.

■ Clients that are not compatible with NetBackup-Java can
use the bp interface. They also support a login from any
NetBackup 7.5 UNIX server’s NetBackup client console
with the jbpSA command.

Clients that are not compatible with NetBackup-Java are
Macintosh OS X, IBM pSeries Linux, and FreeBSD.

NetBackup-Java
compatibility

Installing NetBackup client software
About NetBackup client installation on UNIX

130



About UNIX client installation methods
You can install NetBackup clients on UNIX systems with the following methods:

■ This method installs the client software on the computer
where you run the installation script.

■ To install clients to a location other than the default,
you must create and link a directory before you install
the client software. First create the directory where you
want the software to reside, then create /usr/openv
as a link to that directory.

■ On IBM zSeries Linux clients, you must transfer the
NetBackup DVD or ESD image contents to a location that
is readable by the virtual Linux environment. You can
transfer the image with FTP or NFS mounting
commands.

See “Installing UNIX clients locally” on page 132.

Local installations
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■ You can "push" the client software from your UNIX
NetBackup server to your UNIX client computers. The
UNIX client must be a true client and not a media server
or a master server. The preferred installation method is
to push the client software.

■ Before you can push to a UNIX client, you must first
install the NetBackup client type software on the server.
Then, you must create a policy that includes the client
name.

See “Installing client type software on a master server”
on page 68.

■ You cannot install Windows client software remotely
from a NetBackup UNIX server. Firewalls can also
prevent remote client installation.

■ Clients such as the IBM zSeries Linux may not have a
locally mounted DVD device or access to the NetBackup
DVD or ESD images. In these cases, you must push the
client software from a UNIX master server or a media
server.

■ The following remote installation methods are available:

See “Installing client software with the ftp method”
on page 137.

See “Installing client software with the rsh method”
on page 134.

See “Installing client software with the ssh method”
on page 139.

See “Installing client software with the sftp method”
on page 139.

Remote (push) installations

See “About NetBackup client installation” on page 115.

Installing UNIX clients locally
The following procedure installs the NetBackup client software on a local computer.

To install client software locally on a UNIX client

1 Use one of the following methods to start the installation script:
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■ Insert the NetBackup UNIX Clients DVD into the
drive.

See “About the NetBackup media kit” on page 28.

■ If necessary, mount the DVD.

See “About mounting the NetBackup software
media” on page 53.

■ Enter the following command:

cd_directory/install

The cd_directory is the path to the directory where
you can access the DVD.

DVD

■ Navigate to the location where the installation
images reside.

■ Enter the following command:

./install

ESD images (downloaded
files)

2 When the following message appears, press Enter to continue:

Installing NetBackup Client Software.

Do you wish to continue? (y/n) [y]

The client binaries represent the operating system versions where the binaries
were compiled. The binaries typically function perfectly on later versions of
the operating system. For example, HP PA-RISC 11.11 binaries also are used
on the HP PA-RISC 11.23 level of the operating system. The installation
procedure attempts to load the appropriate binaries for your system. If the
script does not recognize the local operating system, it presents choices.

3 Follow the prompts to complete the installation.

4 After the installation is complete, select Exit from this Script.

About remote installation methods for UNIX clients
You can push the client software from a UNIX master server to a client host by
using the following methods:

■ rsh

See “Installing client software with the rsh method” on page 134.

■ ftp

See “Installing client software with the ftp method” on page 137.

■ ssh
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See “Installing client software with the ssh method” on page 139.

■ sftp

See “Installing client software with the sftp method” on page 139.

Note: For installation in clustered environments, enter the virtual name for the
NetBackup server and not the actual local host name. You can only push client
software from the active node.

Installing client software with the rsh method
Before you perform this procedure, read the following guidelines:

To use this method, the UNIX client must have an entry for
the server in its /.rhosts file. The /.rhosts entries
enable software installation, but they are not necessary for
correct operation of NetBackup software.

Client /.rhosts file

If you want to install client software to a location other than
the default, you must first create and link to the desired
directory. Create the directory where you want the client
software to reside, and then create /usr/openv as a link
to that directory.

Client software location

Make sure that the clients are assigned to a backup policy.Backup policies

By default, this operating system version does not enable
the Remote Shell daemon (rshd). Run the following
command to enable the daemon:

launchctl load -w

/System/Library/LaunchDaemons/shell.plist

For Macintosh OS X

To install client software from a UNIX master server to UNIX clients with the rsh
method

1 Start the NetBackup Administration Console.

2 On the Login dialog box, provide the name of the NetBackup server that
contains the policy configuration with the clients.

You can install the client software only from the NetBackup server that you
specify in the Login dialog box when you start the interface. The clients must
be defined in a policy on this NetBackup server.

3 In the main NetBackup Administration Console window, do the following:
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■ In the left pane where the master server properties appear, click the icon
next to NetBackupManagement. The tree expands to show the available
options.

■ In the center All Policies pane, select the master server.
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4 Click Actions > Install UNIX Client Software.
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5 In the Install UNIX Client Software window, click on the appropriate client
names in the Don’t install these clients list to select the clients you want to
install. Then, click Add >>.

The clients are moved to the Install these clients list.

6 To start the installation, click Install Client Software.

You cannot stop the installation after it has started.

Client software installation can take a minute or more per client. NetBackup
writes messages in the Progress field as the installation proceeds.

During installation, NetBackup copies client software from
/usr/openv/netbackup/client on the server to /usr/openv on the client.

If the installation fails on a client, NetBackup notifies you but keeps the client
in the policy.

7 After the installation is complete, click Close.

Installing client software with the ftp method
Before you perform this procedure, read the following guidelines:
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You must have a login ID and password that you can use to
access the clients through FTP.

Access to clients

If you want to install client software to a location other than
the default, you must first create and link the desired
directory. Create the directory where you want the software
to reside, and then create /usr/openv as a link to that
directory.

Client software location

Make sure that the clients are assigned to a backup policy.Backup policies

By default, this operating system version does not enable
the FTP daemon (ftpd), which is required. To enable the
daemon, run the following command:

launchctl load -w

/System/Library/LaunchDaemons/ftp.plist

Macintosh OS X

To install client software from a UNIX master server to UNIX clients with the ftp
method

1 To move the client software from the server to the /tmp directory on the
client, run the install_client_files script on the NetBackup server.

Use one of the following commands:

■ To move software to one client at a time, enter the following command:
/usr/openv/netbackup/bin/install_client_files ftp client user

The client is the host name of the client.

The user is the login ID that FTP requires on the client.

■ To move software to all clients at once:
/usr/openv/netbackup/bin/install_client_files ftp ALL user

The ALL option specifies that you want to install all clients that are
configured in any backup policy on the server.
The user is the login ID required by FTP on the client.

If you have not set up a .netrc file, the install_client_files script
prompts you for a password for each client.

2 After the script runs, the root user on each client computer must run the
following script:

sh /tmp/bp.<pid>/client_config

The pid is the process ID. The client_config script installs the binaries.
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Installing client software with the ssh method
This client installation method is based on the usage of the SunSSH and the
OpenSSH products, which must be at specific version and patch levels. For more
information about these patches, please refer to the Symantec NetBackup 7.5
Release Notes, Chapter 3: Product dependencies, Table 3-1.

Before you perform this procedure, read the following guidelines:

To use the ssh method, the UNIX client must have sshd
enabled and configured to allow root user logins.

SSH daemon (sshd)

If you want to install client software to a location other than
the default, you must first create and link the desired
directory. Create the directory where you want the client
software to reside, and then create /usr/openv as a link
to that directory.

Client software location

Make sure that the clients are assigned to a backup policy.Backup policies

By default, this operating system version does not enable
sshd. You must first enable this daemon to perform the
following procedure successfully.

■ In the System Preferences pane, select Sharing.

■ Select Remote Login to enable sshd.

Macintosh OS X

To install client software from a UNIX master server to UNIX clients with the ssh
method

◆ On the NetBackup server, run the install_client_files script.

Use one of the following commands:

■ To move software to only one client at a time:
/usr/openv/netbackup/bin/install_client_files ssh client

The client is the host name of the client.

■ To move software to all clients at once:
/usr/openv/netbackup/bin/install_client_files ssh ALL

The ALL option specifies that you want to install all clients that are
configured in any backup policy on the server.

Installing client software with the sftp method
This client installation method is based on the usage of the SunSSH and the
OpenSSH products, which must be at specific version and patch levels. For more
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information about these patches, please refer to the Symantec NetBackup 7.5
Release Notes, Chapter 3: Product dependencies, Table 3-1.

Before you perform this procedure, read the following guidelines:

To use this method, the UNIX client must havesshd enabled
and configured to allow root or non-root user logins.

SSH daemon (sshd)

If you want to install client software to a location other than
the default, you must first create and link the desired
directory. Create the directory where you want the software
to reside, and then create /usr/openv as a link to that
directory.

Client file location

Make sure that the clients are assigned to a backup policy.Backup policies

By default, these operating system versions do not enable
ssh. You must first enable this daemon to perform the
following procedure successfully.

■ In the System Preferences pane, select Sharing.

■ Select Remote Login to enable sshd.

Macintosh OS X

To install client software from a UNIX master server to UNIX clients with the sftp
method

1 To move the client software from the server to the /tmp directory on the
client, run the install_client_files script on the NetBackup server.

Use one of the following commands:

■ To move software to one client at a time:
/usr/openv/netbackup/bin/install_client_files sftp client user

The client is the host name of the client.

The user is the login ID that SSH requires on the client.

■ To move software to all clients at once:
/usr/openv/netbackup/bin/install_client_files sftp ALL user

The ALL option specifies that you want to install all clients that are
configured in any backup policy on the server.
The user is the login ID required by FTP on the client.

2 After the script runs, the root user on each client computer must run the
following script:

sh /tmp/bp.<pid>/client_config

The pid is the process ID. The client_config script installs the binaries.
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Adding a UNIX client after initial server installation
You may want to add UNIX clients after the server installation if you forgot to
select one during the installation. You may also add a new UNIX client type to
your backup environment.

To install client software later, you must first install the NetBackup client software
onto the NetBackup server.

To add UNIX client types to servers after initial installation

1 Use one of the following methods to start the installation script:

■ Insert the NetBackup UNIX Clients DVD into the
drive.

See “About the NetBackup media kit” on page 28.

■ If necessary, mount the DVD.

See “About mounting the NetBackup software
media” on page 53.

■ Enter the following command:

cd_directory/install

The cd_directory is the path to the directory where
you can access the DVD.

DVD

■ Navigate to the location where the installation
images reside.

■ Enter the following command:

./install

ESD images (downloaded
files)

2 When the following message appears, press Enter to continue:

Installing NetBackup Client Software.

Do you wish to continue? (y/n) [y]

The client binaries represent the operating system versions where the binaries
were compiled. The binaries typically function perfectly on later versions of
the operating system. For example, HP PA-RISC 11.11 binaries also are used
on the HP PA-RISC 11.23 level of the operating system. The installation
procedure attempts to load the appropriate binaries for your system. If the
script does not recognize the local operating system, it presents choices.
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3 Select the client type that you want to load and follow the prompts to install
that client type. Repeat as necessary until all of the client types you want are
loaded.

Make sure that you load the software for all of the UNIX client types that you
intend to install remotely from the server.

4 After the installation is complete, unmount the DVD.

5 Install the NetBackup client software on the clients you specified.

See “About remote installation methods for UNIX clients” on page 133.
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Removing NetBackup client
software

This chapter includes the following topics:

■ About NetBackup software removal on UNIX clients

■ Removing NetBackup Windows client software

About NetBackup software removal on UNIX clients
Use the following guidelines when you remove NetBackup from UNIX clients:

When you remove NetBackup client software, PBX is not removed. You must
remove PBX manually. The client software removal procedure in this document
includes a step that describes how to perform this task.

Warning:Do not remove PBX if your client uses other Symantec software products
that require PBX to run.

Removing NetBackup from UNIX clients
Use the following procedure to remove all NetBackup client software components
from a UNIX client.

To remove NetBackup software from a UNIX client

1 Log in to the client system as the root user.

2 Stop the NetBackup daemons by entering the following command:

/usr/openv/netbackup/bin/bp.kill_all
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3 Identify any installed add-on products by using the following command:

lslpp -LAIX

swlistHP-UX

rpm -qaLinux

pkginfoSolaris

Remove each identified add-on product.

4 To unregister NetBackup from the VxUL master configuration that is stored
in the /etc/vx/vrtslog.conf file, run the following command:

/usr/openv/netbackup/bin/vxlogcfg -r -p 51216

The -p option specifies the product ID, which is 51216 for NetBackup.

5 To unregister all NetBackup products with LiveUpdate, enter the following
command:

/usr/openv/netbackup/bin/nblu_registration -r

6 For the clients that support the PureDisk agent, remove all PureDisk files
with the following command:

/opt/pdde/pddeuninstall.sh -forceclean

7 For the clients that support the NetBackup-Java Display Console, remove the
console with the appropriate command as follows:

installp -u SYMCnbjavaAIX

swremove SYMCnbjavaHP-UX

rpm -e SYMCnbjavaLinux

pkgrm SYMCnbjavaSolaris

8 For the clients that support the NetBackup Java Runtime Environment (JRE),
remove JRE with the appropriate command as follows:

installp -u SYMCnbjreAIX

swremove SYMCnbjreHP-UX

rpm -e SYMCnbjreLinux

pkgrm SYMCnbjreSolaris
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9 For native package clients, remove the NetBackup client by using the
appropriate commands as follows:

installp -u SYMCnbcltAIX

swremove SYMCnbcltHP-UX

rpm -e SYMCnbcltLinux

pkgrm SYMCnbcltSolaris

10 Remove PBX with the appropriate native command as follows:

Note: Remember, do not remove PBX if your client uses other Symantec
software products that require PBX to run.

installp -u VRTSpbxAIX

/opt/VRTSpbx/bin/vxpbx_exchanged stop

rm -rf /opt/VRTSpbx

rm -rf /etc/vx/VxICS

Debian

pkg_delete VRTSpbxFreeBSD

swremove VRTSpbxHP-UX

rpm -e VRTSpbxLinux

/opt/VRTSpbx/bin/vxpbx_exchanged stop

rm -r /Library/Receipts/VRTSpbxApp.pkg

rm -r /opt/VRTSpbx

rm -r /etc/vx/VxICS

rm -r /usr/share/man/man1/pbxcfg.1

rm -r /Library/StartupItems/vxpbx_exchanged

Macintosh OS X

pkgrm VRTSpbxSolaris

11 For all clients, navigate to the /usr/openv directory and proceed as follows:

Warning:The rm -f /usr/openv command also removes any add-on products
that are installed on this computer.
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■ If /usr/openv is the actual directory, run the following command:

rm -rf /usr/openv

■ If /usr/openv is a symbolic link to that directory, run the following
commands:
cd /usr/openv

pwd

ls

Warning: Before you continue, make sure that you are at the correct
location and verify that the subdirectories are what you expect them to
be. To help prevent removing the wrong directories, the previous
commands verify your current location and list the files in that directory.
After you verify the directory location and its contents, remove the
directory with the next commands.

rm -rf *

cd /

rm -f /usr/openv

12 For Linux systems only:

If you modified the startup and the shutdown scripts, run the following
command:

/sbin/chkconfig --del netbackup

See “About NetBackup startup and shutdown scripts” on page 151.
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13 Remove the following startup scripts:

/etc/rc.netbackup.aix
AIX

/usr/local/etc/netbackup
/usr/local/etc/rc.d/S77netbackup.sh

FreeBSD

/sbin/init.d/netbackup
HP-UX

/sbin/rc1.d/K001netbackup
/sbin/rc2.d/S777netbackup

/etc.init.d/netbackup
/etc/rc0.d/K01netbackup

Linux Debian

/etc/rc1.d/K01netbackup
/etc/rc2.d/S95netbackup

/etc/rc.d/init.d/netbackup
Linux Red Hat

/etc/rc.d/rc0.d/K01netbackup
/etc/rc.d/rc1.d/K01netbackup
/etc/rc.d/rc2.d/S77netbackup
/etc/rc.d/rc3.d/S77netbackup
/etc/rc.d/rc5.d/S77netbackup
/etc/rc.d/rc6.d/K01netbackup

/etc/init.d/netbackup
Linux SUSE

/etc/init.d/rc0.d/K01netbackup
/etc/init.d/rc2.d/S77netbackup
/etc/init.d/rc3.d/S77netbackup
/etc/init.d/rc5.d/S77netbackup
/etc/init.d/rc6.d/K01netbackup

/Library/StartupItems/netbackup/Resources/netbackup
/Library/StartupItems/netbackup/StartupParameters.plist
/Library/StartupItems/netbackup/netbackup

Macintosh OS X
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/etc/init.d/netbackup
/etc/rc0.d/K01netbackup
/etc/rc1.d/K01netbackup
/etc/rc2.d/S77netbackup

Other clients

14 For AIX systems only:

■ In the /etc/inittab file, remove the following NetBackup entry:

/etc/rc.netbackup.aix

■ In the /etc/rc.shutdown file, remove the following line:

/etc/rc.netbackup.aix stop

15 Remove Symantec LiveUpdate components as follows:

■ First, examine the following file to see if NetBackup is the only product
that uses LiveUpdate:
/etc/Product.Catalog.JavaLiveUpdate

■ If no entries in the file contain the string NetBackup, run the following
commands:
/opt/Symantec/LiveUpdate/uninstall.sh -a

rm -f /etc/Symantec.conf

Note: Before you remove the following product catalog file, make sure
that it is empty. The empty file size is equal to 0 bytes. If the product
catalog file is not empty, do not remove it because other Symantec products
still require it.

rm -f /etc/Product.Catalog.JavaLiveUpdate

16 To remove the NetBackup-Java application state data for the root account,
run the appropriate command as follows:

Warning: Do not insert a space between the slash character (/) and the period
or dot character (.) of "/.veritas". A space between these characters removes
all of your files from the root level and beyond.

■ To remove the NetBackup-Java application state data for the root account
for all releases, run the following command:
/bin/rm -rf /.veritas
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■ To remove the NetBackup-Java application state data for the root account
for a specific release, run the following command:
/bin/rm -rf /.veritas/java/<version>

Where<version> is the six-digit NetBackup version number. For example,
NetBackup version 7.5 with no upgrades applied would be entered as
750000.

17 Inform NetBackup-Java users, that they can remove their $HOME/.veritas
directory and portions of the $HOME/.veritas/java directory.

The $HOME/.veritas/java and $HOME/.veritas directories contain
application state information, that is saved when the user exits
NetBackup-Java applications. The saved information includes table column
order and size. The process removes this directory for the root user only.

The common subdirectory in $HOME/.veritas/java/.userPrefs/vrts can be
removed.

18 If you enabled NetBackup Access Control, NetBackup created new files on
the clients and the servers that can be divided into the following categories:

■ Individual user files
Individual user cache files exist in their home directories (for example, in
$HOME/.vxss). Inform those users that they can remove the $HOME/.vxss
directory.

■ NetBackup application temporary files
NetBackup temporary files are removed with NetBackup.

Removing NetBackup Windows client software
Use the following procedure to remove NetBackup Windows client software.

To remove NetBackup Windows client software

1 If it is open, close the NetBackup Backup, Archive, and Restore interface.

2 Open the Windows Control Panel (select Start > Settings > Control Panel).

3 Select Add/Remove Programs.

4 Select Symantec NetBackup Client.

5 Click Remove.
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Configuring NetBackup

This chapter includes the following topics:

■ About NetBackup startup and shutdown scripts

■ About NetBackup server configuration

About NetBackup startup and shutdown scripts
When you install NetBackup, the installation script also performs configuration
of startup and shutdown scripts. Startup scripts allow the NetBackup daemons
to start automatically when the system boots. Shutdown scripts automatically
terminate the startup scripts at system shutdown.

The installation process copies the NetBackup startup and shutdown scripts to
the appropriate operating system location.

For non-cluster upgrades, any existing NetBackup related startup and shutdown
scripts are saved, and the newly released versions of those scripts are installed.

Table 9-1 lists the links for the startup and the shutdown scripts for the various
platforms that are installed during NetBackup installation.
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Table 9-1 NetBackup startup and shutdown script links by platform

LinksPlatform

/etc/rc.netbackup.aix

■ The NetBackup installation script edited the /etc/inittab
file and added the following entry to ensure that the script is
called during a level-two boot:

netbackup:2:wait:/etc/rc.netbackup.aix

■ To shut down, add the following line to the
/etc/rc.shutdown file:

/etc/rc.netbackup.aix stop

AIX

/usr/local/etc/rc.d/S77netbackup.sh

->/usr/local/etc/netbackup

FreeBSD

/sbin/rc1.d/K001netbackup ->/sbin/init.d/netbackup

/sbin/rc2.d/S777netbackup ->/sbin/init.d/netbackup

HP-UX

/etc/rc0.d/K01netbackup ->/etc/init.d/netbackup

/etc/rc1.d/K01netbackup ->/etc/init.d/netbackup

/etc/rc2.d/S95netbackup ->/etc/init.d/netbackup

Linux Debian

/etc/rc.d/rc0.d/K01netbackup

->/etc/rc.d/init.d/netbackup

/etc/rc.d/rc1.d/K01netbackup

->/etc/rc.d/init.d/netbackup

/etc/rc.d/rc2.d/S77netbackup

->/etc/rc.d/init.d/netbackup

/etc/rc.d/rc3.d/S77netbackup

->/etc/rc.d/init.d/netbackup

/etc/rc.d/rc5.d/S77netbackup

->/etc/rc.d/init.d/netbackup

/etc/rc.d/rc6.d/K01netbackup

->/etc/rc.d/init.d/netbackup

Linux Red Hat
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Table 9-1 NetBackup startup and shutdown script links by platform (continued)

LinksPlatform

/etc/init.d/rc0.d/K01netbackup

->/etc/init.d/netbackup

/etc/init.d/rc2.d/S77netbackup

->/etc/init.d/netbackup

/etc/init.d/rc3.d/S77netbackup

->/etc/init.d/netbackup

/etc/init.d/rc5.d/S77netbackup

->/etc/init.d/netbackup

/etc/init.d/rc6.d/K01netbackup

->/etc/init.d/netbackup

Linux SUSE

/Library/StartupItems/netbackup/Resources/netbackup

/Library/StartupItems/netbackup/StartupParameters.plist

/Library/StartupItems/netbackup/netbackup

Macintosh OSX

/etc/rc0.d/K01netbackup ->/etc/init.d/netbackup

/etc/rc1.d/K01netbackup ->/etc/init.d/netbackup

/etc/rc2.d/S77netbackup ->/etc/init.d/netbackup

Solaris

About NetBackup server configuration
After all server software is installed, you are ready to configure NetBackup to
work with the robotic and the storage devices in your environment. Remember,
these devices must already be configured and recognized by the operating system
before you can configure NetBackup.

See “About storage device configuration” on page 35.

Use the following guidelines when you configure NetBackup:
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The procedures for configuring master and media servers
are very similar. However, Symantec recommends that you
configure all server information such as storage devices
and volumes from the master server. Following this order
helps ensure that the master servers properly administer
the media servers.

Warning: Communication problems between the master
server and the media server do not prevent you from
running the configuration wizards. Therefore, do not run
the wizards on the media server until the problems are
corrected. If you run any of the wizards when a
communication problem exists, the master server cannot
recognize the information that you enter. You must first
correct the problem. After you correct the problem, run the
configuration wizards from the master server.

NetBackup Enterprise
servers

■ Configure devices on every node in the cluster.

■ Start by configuring all storage devices from the active
node so that they work with NetBackup.

■ For a NetBackup failover server, attach all of the devices
to each node in the cluster on which NetBackup is
installed. Refer to the clustering vendor’s documentation
for information on how to migrate to another node.

■ Unless otherwise noted, configure NetBackup to use the
virtual host names of master servers and media servers
in the cluster.

For complete information on to how to configure an
add-on product to fail over, see theNetBackupClustered
Master Server Administrator's Guide.

Clustered environments

For initial NetBackup server configuration, Symantec recommends that you launch
the NetBackup Administration Console and click the GettingStarted icon. A series
of wizards guide you through the following configuration procedures:

■ Configure Storage Devices
See “About the Device Configuration Wizard” on page 156.

■ Configure Volumes
See “About the Volume Configuration Wizard” on page 158.

■ Configure the Catalog Backup
See “About the Catalog Backup Wizard” on page 159.

■ Create a Backup Policy
See “About the Backup Policy Configuration Wizard” on page 160.
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If NetBackup is already configured and you want to change a specific area, click
the appropriate wizard on the NetBackup Administration Console.

For complete information on all of the NetBackup wizards and how to configure
NetBackup, see the NetBackup Administrator's Guide.

See “About storage device configuration” on page 35.

Starting the NetBackup Administration Console
Use the following procedures to open the NetBackup Administration Console to
configure NetBackup. The GettingStarted wizard guides you through the primary
configuration steps to make NetBackup function.

Note: Other wizards are available from the initial NetBackup Administration
Console window that are not part of the GettingStarted wizard. For example, you
can configure disk pools or create a snapshot backup policy. See the NetBackup
Administrator’s Guide, Volume I for complete information about all NetBackup
wizards.

On Windows systems, if you clicked the checkbox LaunchAdministrationConsole
that appears at the end of NetBackup installation, you can skip this procedure.

To start the NetBackup Administration Console on Windows

1 Log on to the NetBackup server as the Administrator.

2 Click Start>Programs>SymantecNetBackup>NetBackupAdministration
Console.

3 To begin configuration, on the Administration Console, click GettingStarted.

The Getting Started screen appears and prompts you to begin device
configuration.

Note: If you still need to configure devices to work with the operating system,
close the wizard. You must first configure those devices as specified by the
device and the operating system vendors.
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To start the NetBackup Administration Console on UNIX

1 Log in to the NetBackup server as root.

For clustered environments, log in to the active node as root.

If you need to run the user interface on a computer other than the NetBackup
server, log on to that computer. For UNIX systems, log in as root.

2 Enter the following command:

/usr/openv/netbackup/bin/jnbSA &

3 Enter the password for root.

For clustered environments, when you log in to the NetBackup Administration
Console, specify the virtual host name in the Host field.

4 Click Login.

5 To begin configuration, on the Administration Console, click GettingStarted.

6 On the initial Getting Started screen, review the content and click Next.

The following screen prompts you to Configure Storage Devices.

Note: If you still need to configure devices to work with the operating system,
close the wizard. You must first configure those devices as specified by the
device and the operating system vendors.

About the Device Configuration Wizard
Before you can run backups, you must define your storage devices for NetBackup.
This wizard guides you through this process. However, you must be certain that
you have configured your storage devices correctly for your operating system.
NetBackup cannot function reliably unless devices are installed and configured
correctly.

See “About storage device configuration” on page 35.

For clustered environments, begin configuring all storage devices from the active
node. For a NetBackup failover server, Symantec recommends that you attach all
of the devices to every node on which NetBackup is installed.

For complete instructions, refer to the NetBackup Clustered Master Server
Administrator's Guide.

This wizard takes you through the following processes:

■ Scans the hosts for backup devices
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■ Verifies the devices that were automatically detected

■ Verifies and corrects the drive configuration

■ Updates the device configuration

The wizard presents the following information when you configure devices:

■ When the wizard displays the DeviceHosts screen, you
must specify the hosts on which to auto-discover and
configure devices (NetBackup Enterprise servers only).

■ When the wizard displays the Backup Devices screen,
confirm that the list of devices is complete and accurate.
If a known backup device does not appear in this list,
take the following action:

■ Verify that the backup device is physically attached
to the host.

■ Verify that all installation procedures specified by
the device and by the operating system vendor have
been performed successfully.

■ Verify that all drives correspond to the proper device.
If you need to move a drive, select the drive and drag
it to the correct location.

■ For clusters, ensure that you perform storage device
configuration on each node. Begin on the active node,
then move the NetBackup active node to another node
and perform the storage device configuration on that
node. Repeat for each node of the cluster on which
NetBackup runs.

Note:By default, robotic daemons and NetBackup add-on
products do not cause NetBackup to failover if they fail.
You can configure robotic devices and NetBackup add-on
products to fail over NetBackup if the robot or the add-on
product fails. Before you configure NetBackup to failover,
robots must be configured and recognized by the
operating system. For complete details about fail over
configuration, refer to the NetBackup Clustered Master
Server Administrator’s Guide.

Device configuration
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■ You define storage units from the Configure Storage
Units screen. If your system does not have a tape device,
you can store data on a disk by defining disk storage
units.

■ When you enter a path for a storage unit, the following
rules apply:

■ Use the correct path separators (forward slash (/) for
UNIX and backward slash (\) for Windows).

■ Use a colon (:) to specify a drive separation on
Windows platforms.

■ Use the following characters only:

Alphabetic characters (ASCII A-Z, a-z)

Numeric characters (0-9)

Miscellaneous characters: plus (+), minus (-),
underscore (_), or period (.)

Defining storage units

See “About the Volume Configuration Wizard” on page 158.

About the Volume Configuration Wizard
After you have configured your storage devices, the Getting Started Wizard starts
the Volume Configuration Wizard. However, if you only have disk storage
capability, NetBackup skips this wizard.

This wizard lets you initiate an inventory of each configured robot. NetBackup
automatically updates the volume database if it finds new robotic media during
the inventory. In addition, you can define new volumes for use in stand-alone
drives.

For complete information about volumes or volume configuration for stand-alone
drives, refer to the NetBackup Administrator's Guide, Volume I.

Note: For clustered environments, configure volumes from the active node.

This wizard lets you do the following tasks:

■ Select a device for volume configuration

■ Perform an inventory of the robot

■ Create new volumes

■ Create new volume groups

The wizard presents the following information when you configure volumes and
perform inventory:
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■ NetBackup conducts an inventory of the robot or the
device that you selected. To view the results after the
inventory has completed, see the Results: field.

■ After the device inventory has completed, the wizard
prompts you to identify which device slots contain
cleaning media.

If you upgraded NetBackup and have pre-existing
barcode rules, the barcode reader automatically detects
the designated slots for the cleaning media. If you do
not designate cleaning slots, NetBackup considers all
media (including cleaning media) as typical media and
tries to overwrite it.

■ After the inventory has completed, you are prompted to
identify which device slots contain cleaning media.

If you identify one or more slots as cleaning media in
the Identify Cleaning Media screen, you see the Robot
Inventory(CleaningMedia) screen. This screen displays
the results after the software updates the EMM database.

If you do not designate cleaning media, NetBackup
considers all media to be typical media (including
cleaning media) and tries to overwrite it.

Robot or device inventory

■ Specify the number of volumes for the device.

■ The wizard does not let you configure cleaning tapes for
standalone drives.

Standalone drives

When you specify multiple drive types, the following are
true:

■ Media that is written by one robot drive may not work
in any other drive. If this situation occurs, NetBackup
considers the robot to have more than one type of drive.

■ If the robot has more than one type of drive, the wizard
cannot inventory the robot.

Multiple drive types

See “About the Catalog Backup Wizard” on page 159.

About the Catalog Backup Wizard
The NetBackup catalog contains information about your configuration and the
locations of backed up files and directories. If a disk fails and your catalog is lost,
a catalog backup makes it easy to restore your data and resume your backup
schedule.

Therefore, you must configure a catalog backup policy before any data gets backed
up.
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This wizard lets you create a policy for an online, hot catalog backup. Online, hot
catalog backups can back up the catalog while normal client backups are in
progress.

A catalog backup policy lets you specify the following information:

■ The destinations for the catalog backup
A backup destination can be any configured storage device. For additional
disaster recovery protection, you can specify a second location for your catalog
backup.

Note: Although NetBackup supports catalog backup to disk, Symantec
recommends that you back up the catalog to removable media that gets stored
offsite.

■ When the catalog backup occurs

■ The location of the disaster recovery file that is needed to recover from the
catalog backup

Use the following guidelines to configure a catalog backup:

■ Configure a catalog backup policy before any other files or data are backed up.

■ For clustered systems, configure the catalog backup policy from the active
node.

For complete details about catalog backups, see the chapter "Protecting the
NetBackup catalog" in the NetBackup Administrator's Guide, Volume I.

For instructions on how to configure a catalog backup in clustered environments,
see the NetBackup Clustered Master Server Administrator's Guide.

About the Backup Policy Configuration Wizard
This wizard lets you define a backup policy for a group of one or more clients. For
clustered environments, configure the policy from the active node.

The wizard lets you specify the following:

■ Policy names and types

■ Clients

■ Files and directories to back up

■ Backup types

■ Backup rotations
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■ Starting times of backups

The wizard prompts you to choose the type of backup that you want a policy to
perform.

Table 9-2 describes the available backup types.

Table 9-2 Backup type descriptions

DescriptionBackup type

Backs up all files that are specified in the file list.Full backup

Backs up all the changed files that are specified in the file
list.

Incremental backup

Also referred to as a Differential incremental backup.

Backs up the files that have changed since the last successful
incremental or full backup. All files are backed up if no
previous backup has been done.

Differential backup

Also referred to as a Cumulative incremental backup .

Only the files that changed since the last full backup that
was successful are backed up. All files are backed up if no
previous backup has been done.

Cumulative backup

Initiated manually by a user to back up specific files.User backup

Use the following guidelines when you create backup policies:

■ The list that appears on the Client List screen of the Backup Policy Wizard is
a list of clients that are backed up. You can add, change, or delete clients from
the list.

■ You can select how often you want a backup policy to run for full or incremental
backups. In addition, you can select the retention period for the backups.

After you have completed the Backup Policy Wizard , you are asked if you want
to perform an installation verification test. To do this test, click the Activity
Monitor in the left pane of the NetBackup Administration Console. You can now
monitor the progress of the backup job.
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